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Welcome

geometry
expressions

Geometry Expressions is the world's first application that lets you visualize
geometry and formulate symbolic expressions by constructing a sketch.

Simply sketch your geometry, add symbolic constraints, and then
automatically output symbolic measurements and expressions.

Geometry Expressions is based upon work supported by the National
Science Foundation under Grant No. 0750028

Need Help?

There are many ways to get help with Geometry Expressions.
In both the PDF manual document and the embedded Help system you
can:
e Use the table of contents to get details on using a tool, an icon or a
menu.

e Use the index for help on a particular topic, such as "parametric
equations".

Inside the Geometry Expressions Help system you can:

e Use the Search tool to find all topics based on a key word, such as
"constraints".

e Browse through help with the up - "Previous page", and down - "Next

© 2012 Saltire Software
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Page" arrows ¥ * . This will step you through the help subtopics in a
logical sequence.

e You can click on colored text which links you to more information.

Tool Tips:
When you move the cursor over any icon on the screen, the name of the
icon appears briefly below the cursor.

Linked Text

Some words in the program's Help system are highlighted and underlined.
When you place the cursor over this text, the cursor becomes the hand
symbol. This text indicates a link to more information on the subject. Click
the text to jump to the related help page.

© 2012 Saltire Software



The Display and How It's Organized



14 Geometry Expressions Manual

Many of the menu items in the drop down menu bar at the top of the
screen correspond to one of the icons or buttons across the top of the
display window or in one of the toolboxes.

Icons across the top of the screen comprise the standard Windows File,

Edit, View and Help commands. The construction and calculation tools

are displayed along the side of the drawing window. These toolboxes can
be displayed on the left or right panel, top or bottom panel, floating in a

separate window, or hidden.

The Output window can be displayed below the drawing window to show
large expressions.

The status bar at the bottom of the window displays the following (from
left to right):

<Menu Help> <Current Mode> <Cursor Coordinates> <Angle Mode>

@& Geometry Expressions El@lle
File Edit Miews Draw Annotake  Constrain (Input)  Construct  Calculate (Oukput)  Help Henu’ ICD“ Bar

EHBEVEH G vREEHD Y QQQEEAQ @

ssini.gx > | {1 Lemniscate.gx raph ax Drraw TDDI PEIEI ax

sl CIRR/YRZE
T PageTahs/km EEBERRES

Constrain (Input) o=
2 DILNKY?
2D 2, I\ ;’,’;’ x 2.

Construck a

/fl..-/__lf

*

@ x Output Window [ 7™ s |_gott®
K2t vyt xt et v alated=o o&‘g%'ﬁ/
TR

Symbols

Greek Lower | Greek Upper
afBly |8 e]&]n|0]
Ready Selecting (9.14628,-2,85769) Status Bar
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The Status Bar

The status bar at the bottom of the screen prompts the following
information (from left to right):

Ready Moving geometry (-8.6875,-6.68471) Radians
e Menu Help - summary of a selected menu item.

e Current Mode - Each icon in the drawing toolbox represents a mode.
Tools requiring additional inputs after clicking the tool will display
further prompts in this field.

e Cursor Coordinates - Displays the current coordinates of the cursor
in the diagram.

e Angle Mode - A drop down window for conveniently changing from
Radians to Degrees and visa versa. This default can also be changed
in the Preferences dialog - Edit / Preferences / Math.
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You can arrange the display as it suits you.

Arranging Toolboxes - Anchored or floating toolboxes can be
placed around the drawing window.

Hide / Show Toolboxes - You may want to hide toolboxes which
you rarely use.

Saving your configuration - Use the View / Tool Panel
Configurations.

Arranging projects - You can open multiple project files and
arrange them in the drawing window using the page tabs.

In the example below three toolboxes (Draw, Constrain (Input), and
Construct) are anchored, two (Calculate (Output) and Variables) are
floating, and three (Anotate, Symbols, and Annotation Symbols) are
hidden. Two slightly different locus examples are displayed for
comparison.
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& Geometry Expressions |._||E|f'>__(|
File Edit ‘“iew Draw Annotate  Constrain (Input)  Construck  Calculate (Output)  Help

Eﬂ[ﬁ%iuﬁ#ll@ﬁ@ %%@@I@
Draw Constrain {Input)
E’IE’IEIE’IE’I@ DALY //
& EPNEER 51 L NG
FEE=EGE

() Cassinigx Conskruct o x
RS VS JT SRS ST I S T R S\ L LN NGl
= K2 XYY 2 K a2 Y at-at k=0 o /] IEIEXAY |
0 Symbalic |Real |
Ly | x)
‘ / D 2 A
. c DY
(-a.0) (a.0) |
P | 5 able it
= —| Variables | Functions |
) Lemniscate.gx 3
Mame Yalue Locked
1,.4570313
=yt vyt a2 vt a0 - 0 e
(=) )
¢ | 5]|| N | [
Ready Selecting (4.23008,1, 74643) M P> W By —

Arranging Toolboxes

You can move the toolboxes around the periphery of the drawing window
by clicking the title bar and dragging.

Click the pushpin on the upper right corner of individual toolboxes to make
it a "floating" box that you can drag anyplace on the screen. Floating
boxes have a colored title bar -
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Constrain (Input) 1" Constrain (Input)

2 2N 2N ?7- w
To re-anchor the toolbox, drag the box until a blue shadow appears at the

position where you want it, then release the mouse button. You may want
to readjust the screen size for optimal viewing.

Annotate 0 x
A DALAA A

M A\A| Ay As

Hiding / Showing Toolboxes

Use the X on the upper right corner of individual toolboxes to hide them.

Constrain (Input) ﬂ@
L, 2] 2K 8
MDD NI

Construct J.',l®

AN WA/ At e
QG VG2 A

Calculate (Qutput) (%)

To display a hidden toolbox, select View / Tool Panels. The submenu
lists the toolboxes and the Main Toolbar (the icon strip at the top of the
window). Boxes shown are preceded by a check, those without a check are
hidden.

© 2012 Saltire Software



Customizing Your Display 21

Axes A <)

E:d B dari Construct
ge Boundaries .
« Man Toobar
Tool Panel Configurations B Draw
v Constrain (Input)
Output v Annotate
Language ¥ W Construct
v Calculate (Output)
v Symbaols
Annotation Symbaols
v Variables

Click a toolbox name to change its state.

Saving the Configuration

After configuring the screen to you preference, you can save this
arrangement in case it gets messed up, or perhaps you need the tools
arranged differently for different projects. This is easy with the View /
Tool Panel Configurations menu selection. You can give a name to an
arrangement of the toolbars. Several configurations can be saved in a list
and referred to as needed.

Pane Boundaries

Tool Panels ]

Tool Panel Configurations add...
Delete, ..

Cukpuk et

Language » Drefaulk

Add - to save the current screen configuration. You will be prompted for
a name to reference this configuration.

Delete - if you no longer will use a certain configuration you can delete it
from your list.

Set - to change a configuration which you have saved, simply select the
configuration name from your list. Check out the configurations that
come with the program.
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Set Tool Panel Configuration g

Select configuration

Geometry Expressions
Geometry Publishing

above&left
left side
right side

oK, | | Cancel

Default - reset tool panels back to the default configuration.

Arranging Project Pages

You can open multiple project files for quick reference. By default files are
overlaid. Click a page tab to bring a file to the top.

Comparing drawings side by side - click the page tab and drag it to
one side, top, or bottom of the window. A shadow of the drawing gives
you an indication of how the drawings will be arranged before you release
the mouse button.
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% Lemniscate.gx ¢ Cassinigx

[

= X' v vt xialovia

Returning to overlaid configuration - drag one tab and position it over
the other tab. The shadow will appear only on the title bar, then release
the mouse button.
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b =2 vivhaxalaviadzg Al
- a‘

i
(-a,0) .
o o

{ b Cassinigx

2 -

Changing Background Color

You can now change the drawing's background color to something other
than white by the following steps:

1. Select Edit / Preferences... (or in the Mac version, Geometry
Expressions / Preferences...)

2. Click Grid, Axis, Page button

3. Change Fill Color in Background section. The color will be applied to
all pages.
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Preferences

pe=====

[ |

Selection

Geometry
ABC
el
Text & Pictures

Grid, Axis, Page

Grid, axis and page properties

25

x)

B

AXes

Lire Calor B g

Ling Skyle Solid

Line Thickness | 1

Font 10; Swiss; Arial; Mormal; Mormal; Mok Underlined; Bladk,
Show Labels | True

Inits Decimal

Subdivisions  Mone

Fill Color

Line Color |:| Silwer
Line Skyle Solid

Line Thickness | 1

YWisible False
Minor Grid

Lire Color [ ] silver
Ling Skyle Dok

Line Thickness 1
Subdivisions  Auto

Page Boundary

[

(0].4

] [ Cancel
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Select Preferences from the Edit menu (or in the Mac version,
Geometry Expressions / Preferences...) to modify the program's

defaults.

The default settings are grouped by type, listed on the left side of the
Preferences dialog. Click the icon to display the desired page.

These settings are also available for editing a selected object or group
of objects individually without changing the defaults, using the
Selection Context Menu.

Preferences

Selection

Geometry
ABC
22

|
Text & Pictures

Grid, Axis, Page

Math properties

X

=

EH O H

Annotation

Line Color

Line Skyle

Line Thickness
Fank

Calculation {Output)
Line Color

Line Skyle

Line Thickness
Fonk

Line Equation Style
Constrain (Input)
Line Color

Line Skyle

Line Thickness
Fank

Expression

Fank

Finned

Math

angle Mode

B o

Solid
1
10; Swiss; Arial; Marmal; Mormal; Mok Underline

[ (140,140,140

Solid

1

10; Swiss; Arial; Mormal; Mormal; Mok Underline
ax+by+c=0

[ 130,130,255

Solid

1

10; Swiss; Arial; Marmal; Mormal; Mok Underling

10; Swiss; Arial; Marmal; Mormal; Mot Underline
False

Radians

Intermediate Yariable Complexity (2 ko 100) | 15

(a4 ] [ Zancel
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:“[%* set the line color and style for each selection type.
Selection
mj set font related properties for labels; color and size /
style for other geometric elements.
Geometry
-’@f set font properties for text, the rotation angle and the
’-ﬁg transparency level of an inserted picture, and the

Pinned state for Text and Pictures. Pinned Text and
Pictures will not move relative to the Page
Boundaries as the result of a Scale operation.

Text & Pictures

g,é} set the properties for alphanumeric input and output;
- il mathematical calculation defaults.
Math
1= set properties of the Major and Minor Grid, the
Bl coordinate Axes, the drawing's background color, and
Grid, Axis, Page the Page Boundary lines.

To see the possible values for each property, click the row. An icon will
appear at the right end of the row (except the Point Size selection under
the Font property -you can enter the point size directly).

B Math
Angle Mode Radians
Intermediate Variable Complexity (2 to 100) | 15
Precision Type Significant Figures
Decimal Digits {0 to &) 3 Digits

Click the icon to display the selection dialog Eﬂ or drop-down menu of
choices *.

E Math
Intermediate Variable Complexity (2 to 100) ELERE k‘
Predsion Type Degrees
Decimal Digits {0 to 8) & Digits

Changing a default for a type of drawing entity will apply to all entities of

© 2012 Saltire Software



30 Geometry Expressions Manual

that type except ones whose properties have been individually set, by
selecting it and then choosing Edit / Properties or right clicking All
Properties from the Selection Context menu. Likewise, text, pictures

G
or expressions that were individually pinned QE or unpinned

ircle’
% will not be affected by changes to the default Pinned settings.
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Geometry Expressions uses standard Windows file Ogn and Save

operations. Save your files regularly with the handy icon at the top of

the screen.

The data files generated from your drawings will have the extension ".

gx".

You may create multiple data files and have them open in a session. Each
file is on separate page with the tabs across the top of the drawing
window. Click the tab to view the file.

If you are preparing a multi-paged lesson, you can save the pages
together as a Workbook, with the file extension ".gxw". This is a
completely separate file from the .gx files.

The Open / Save (As) / Close Workbook file selections apply only to the
workbook. and the File / Save commands will NOT save the
workbook files. They only affect the individual .gx files.

Files can also be arranged for comparison viewing.
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{® Geometry Fxpressions

File Edit “iew Draw Annotate Constrain (Input) Consktruct  Calculate (Output)  Help

EHROH SN +3BEE O Q]

() CIrcle squeeze.gx | { ) Lemniscate.gx { "y ExampleSa (Apollonius Cirde).gx

Locus of a Circle tangent to two circles

The locus of the center of the circle EF as its radius rvaries is an ellipse.
Find its center and principal axes

= 4P a s 0 (45848 sttt ol (Batrad b (B shta s O

Wookbooks and Individual .gx Files

Workbooks are a handy way of putting lessons together.
e You can make a workbook by opening new tabs (File / New).

e You can Open .gx files that you have already created to make them
part of your workbook.

e You can create pages from a combination of the above.

& Geometry Expressions
File Edit WView Draw Annotate Constrain (Input)

Rl B K wERBI

{ ' chap9.gx C) basic parabnla.gxé * | ¢y unnamed4

When all of the pages are together on the page tab bar, select Save
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Workbook (As) from the file menu.

@ Note: saving the workbook does NOT update any of the individual .gx
files displayed in the workbook, since the workbook file is an entirely
separate file (.gxw). If you want to keep the individual .gx file up to date
with the workbook page, you must use the regular File / Save for each
page / file. But, if you forget, you can always save it from the workbook
at any time.

Likewise, saving an individual page, File / Save, of an open workbook
does NOT update the workbook file (.gxw). However, if you forget to save
the workbook, but save a page (.gx), you can always open the .gx file
again from your open workbook file and resave the workbook.

If you don't want to keep individual copies of all your workbook pages,
then you just have to remember to use the Save Workbook file
selection.

However, to give the workbook pages custom names (instead of
unnamed7.gx), you must save the individual page (for example, Lesson 1
Ellipse.gx) at least once. After the first time, you don't need to continue
to save the .gx file.

Only one workbook file can be open at a time. If you open a workbook file
while other individual files or another workbook file is open, they will be
closed, after, of course, prompting you to save them if you have made
changes.
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All mathematical expressions in Geometry Expressions are written in
MathML, so you can copy and paste directly to or from any other MathML
program.

Usually the standard Edit / Copy or Ctrl-C command should work. If this
doesn't give you the desired result, try the Edit / Copy As command.
Select from the submenu of choices appropriate to your application.

If you copy an expression that uses Intermediate Variables, the algebra
system will create a function from the pasted expression.

To Paste math into Geometry Expressions it must be Content MathML.
e Maple creates Content MathML by default.

e To create Content MathML in Mathematica v6.0, execute the following
commands:
SetOptions[ XML MathML " ExpressionToMathML, "NamespacePrefixes"
> {}, "Formats" > {"ContentMathML"}]

SetOptions[XML" MathML" BoxesToMathML, "NamespacePrefixes" > {},
"Formats" > {"ContentMathML"}]

SetOptions[Export, ConversionOptions > {"NamespacePrefixes" > {},
"Formats" > {"ContentMathML"}}]

SetOptions[ExportString, ConversionOptions > {"NamespacePrefixes"
> {}, "Formats" > {"ContentMathML"}}]
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Your installation comes with several examples - look in the Examples
subdirectory. For step by step instructions through some example sets,
see the Geometry Expressions Tutorial.pdf and Geometry Expressions

Examples.pdf which can be found under the Doc subdirectory in your Gx
installation.
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Drawing

Using the Drawing Tools

The Draw toolbox contains the drawing commands and the Selection
Arrow. The drawing commands can also be invoked from the Draw menu.

Draw

FRRRIEGE
B ERRRES
FEER

Unlike commands in the other toolboxes, Drawing commands are always
available and require no pre-selection. Many of the commands are active

......

------

arrow cursor, [E, is used for invoking all other commands. You can find
the active command mode by noting which button is pressed or looking at
the current mode on the status bar.

E & X = Z] [ci

Point Line Infinite Vector Polygon Circle
Segment Line

Ellipse Parabola  Hyperbola  Arc N-gon Curve
Approximation

Text Picture Expression  Function
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Before you start your drawing, select Edit / Preferences / Geometry to
set various attributes, such as line color / style, fill color / style and
transparency level, of the various drawing elements.

You can change the attributes of individual drawing elements by selecting
them, right click the mouse, and choose All Properties from the context
menu.

Adding a Point

Draw

‘\

x@@@@
e mEe

To insert a point in your drawing, follow these steps:

1. Click the Point icon E/I in the Drawing toolbox or select Point from
the Draw menu.

2. Move the crosshairs _+_ into position.

3. Click the mouse to place the point under the crosshair.

When the crosshairs are positioned over some geometry an incidence
symbol (bowtie) is displayed around the point and the geometry is
highlighted. A click of the mouse will create the point incident to the
highlighted geometry.
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Each point is dlsplayed with a letter label. You can change the label from

the Select mode .FL

Point is a modal command. You can continue making points until you
choose the select arrow or another drawing tool.

Adding Line Segments

Draw

E’li’li’l
EEER

To add line segments to your geometry follow these steps:

1. Click on the Line Segment icon BI in the Draw toolbox or select
Line Segment from the Draw menu.
2. Position the cursor _+_ in the drawing window.

3. Click the mouse to place each endpoint.

Each line segment is displayed with a letter label for each endpoint.

B

A

L

You can change the label from the Select mode b

To abort a line segment in the middle of the drawing operation, hit the
"esc" key.

Line Segment is a modal command. You can continue making segments
until you choose the select arrow or another drawing tool.
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Drawing Lines

Draw

AERAT
FEEC

Lines are similar to line segments except they have infinite length.

1. Click the Infinite Line icon @ in the Draw toolbox or select Infinite
Line from the Draw menu.

_|_

3. Click the cursor to anchor the line at the cursor position. The anchor
point will be displayed on the line.

2. Position the line cursor in the drawing window.

4. Move the cursor in the drawing window to position the line and click
the cursor when you get the line in the desired orientation.

Lines are infinite and do not have points associated with them unless you
specifically place one on the line.

Line is a modal command. You can continue making lines until you
choose the select arrow or another drawing tool.

Active Axes -

The x and y axes have the properties of perpendicular infinite lines. When
the crosshairs are positioned over an axis, the incidence symbol (bow tie)

is displayed at the intersection and the axis is highlighted. ; When
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the cursor is at the origin, both axes are highlighted | . Points and
End points of line segments can be placed directly on the axes without
using the Constrain / Incident tool when the bow tie is displayed.

Drawing Vectors

Draw

FRROZIT
B [ i1t
ZEER

To add vectors to your geometry follow these steps:

1. Click the Vector icon EI in the Draw toolbox or select Vector from
the Draw menu.

2. Position the cursor _+_ in the drawing window.
3. Click the mouse to place each endpoint.

Each vector is displayed with a letter label for each endpoint.

Drawing vectors is similar to drawing line segments, but vectors are
constrained with coefficients of the form:

A

Vector is a modal command. You can continue making vectors until you
choose the select arrow or another drawing tool.
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Drawing Polygons

Draw

E’IE’IEIE’I
FEEE

You can quickly create a multisided figure with these steps:

1. Click the Polygon icon @ in the Draw toolbox or select Polygon
from the Draw menu.

2. Position the cursor _+_ in the drawing window.
3. Move the cursor and click once to place each vertex.

e As you create the sides of the polygon, each vertex is
automatlcally assigned a letter name. You can change the label in

------

Select L.Ff.; mode.

e When you create the last side of the polygon by clicking on the
first vertex, the polygon will be filled with the default fill color,
style and transparency.

. To change the appearance of the polygon (color or style), select

......

______ iit, right click, and choose All Properties from the context
menu.

e Polygon is a modal command. You can continue making polygons
until you choose the select arrow or another drawing tool.

Polygons can be filled with the color, style, and transparency level of your
choice. See the Edit /Preferences menu, Geometry tab to set the
default. To change the color / style /transparency level of selected
polygons, select the polygon(s), right-click, and select All Properties
from the Selection Context menu (or Edit / Properties from the menu
bar).
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Drawing Circles

[ e )
B =< prijmiwis
RE=EC

To add a circle to your diagram, follow these steps:

1. Click the Circle icon @ in the Draw toolbox or select Circle from the
Draw menu.

2. Move the cursor _+_ in the drawing window to the position of the
center of the circle and click once.

3. Move the cursor to draw the circle in the desired size and click again.

Notice the circle is displayed with 2 points, the center and a point on the
perimeter.

B

Circle is a modal command. You can continue making circles until you
choose the select arrow or another drawing tool.

------

You can adjust the circle in Select %1 mode.

Circles can be filled with the color / transparency level of your choice. See
the Edit /Preferences menu, Geometry tab to set the default. To
change the color / transparency level of selected circles, select the circle
(s), right-click, and select All Properties from the selection context menu
(or Edit / Properties from the menu bar).
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Drawing Ellipses

Draw

FRRRZC
FEERE

To create an ellipse in your diagram, follow these steps:

1. Click the Ellipse icon B in the Draw toolbox or select Ellipse from
the Draw menu.

2. Move the cursor _+_ in the drawing window to the position of one focal
point. Click to place the first focus point. Move the cursor and click
again to place the second focal point.

3. Then move the cursor to open the ellipse to the desired shape and
click the mouse a third time.

A

The ellipse will appear with three labeled points, the two foci and a point
on the ellipse.

The Ellipse tool is a modal command. You can continue making ellipses
until you choose the select arrow or another drawing tool.

Ellipses can be filled with the color / transparency level of your choice. See
the Edit /Preferences menu, Geometry tab, Conic properties group to
set the default. To change the color / transparency level of selected
ellipses, select the ellipse(s), right-click, and select All Properties from
the selection context menu (or Edit / Properties from the menu bar).
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Drawing Parabolas

Draw

JRXEEE

To create a parabola in your diagram, follow these steps:

1. Click the Parabola icon @ in the Draw toolbox or select Parabola
from the Draw menu.

2. Move the cursor _+_ in the drawing window to the position of the
parabola's vertex. Click and drag the mouse along the major axis.
Release the mouse at the focus.

After sketching the general parabola, you can constrain it in the following
ways:

%
1. Click the parabola and select Implicit equation ?): from the
Constrain toolbox and type or paste the formula.

F
'S a:—‘f: I a+Y*b+2-X-Y E:d F:—fFU

N~

2. Constrain the vertex and focus points to some coordinate values.
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Draw

CIRRERZEEX
t gre=Ens
Constrain (Input) o x
L DI NLH B
A 2, N\

Construct o

{ by unnamed3

| ¥ II ' _,—-

04&5%%%

3. You can also adjust the parabola with the Translation, Rotation and
Dilation tools.

Drawing Hyperbolas

Draw

@@@B@B

To create a hyperbola in your diagram, follow these steps:

1. Click the Hyperbola icon @ in the Draw toolbox or select
Hyperbola from the Draw menu.

2. Move the cursor _+_ in the drawing window to the position of one
focal point. Click to place the first focus. Move the cursor and click
again to place the second focal point.

3. Then move the cursor to open the hyperbola to the desired shape
and click the mouse a third time.
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—" .

The hyperbola will appear with three labeled points, the two foci and a
point on the hyperbola.

The Hyperbola tool is a modal command. You can continue making
hyperbolas until you choose the select arrow or another drawing tool.

Drawing Arcs

Draw

i [ 4 [ 4| A e
& BQRO@
FE=EE

Arcs can be placed on any of the conics - circle, ellipse, parabola,

hyperbola - or any function. Points are automatically placed at the ends of
the arc.

Here are the steps:

1. First draw the conic or function which will be the basis for the arc.

2. Choose the Arc tool @ and move the cursor over the section of the

existing curve where the arc will be defined. Click and drag the cursor
over the curve.
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Endpoints are automatically inserted on the arc.

Curvilinear Polygons

The Arc drawing tool lets you make curvilinear polygons for which you can
assign fill properties and find areas. There are some limitations, however.
Since you can't construct point on two intersecting curves (except for
circles), you have to connect curves with line segments. If you want to

connect two arcs, you have to first connect them with a line and move it
to the intersection like this:
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Y=8-X*a

v ¥
1 t

i) > 2
Y=X%a

To make a curvilinear polygon of the intersecting parabolas here are the
steps:

e Attach two lines.

e Make endpoints C and D -t point proportional along the curves.
e Make endpoints A and B t point proportional along the curves.
e Draw the two arcs - select Draw / Arc, from C to A and D to B.

e Select the sides and arcs of the polygon in order and click
Construct / Polygon.

e Set t=2 in the Variables toolbox and the lines will become the
intersection points.
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Variables X
Variables | Functions |
Mame Value Locked
a 1 -
t 2 =

)

it 2|) n
[t >) () @) —

-1.041666 '®|4_|: 2

J
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It's easier with circles because you can place points on their intersections:
C

© 2012 Saltire Software



Tools 55

Drawing Regular Polygons

Draw

The N-gon tool lets you quickly draw any regular polygon. You can even
work on problems where the number of sides is n, or whatever variable
you choose.

Here are the steps:

1. Click the N-gon button EI in the Draw toolbox.

2. Similar to drawing a circle, position the cursor to place the center of
the n-gon and click to the desired size. The n-gon at first appears to
be a pentagon.

3. In the data entry box, enter the humber of sides you want or a
variable to represent the number of sides and press Enter.
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Drawing Curve Approximations

Draw

cESTEE
& OQNEE
AE=ER

The Curve Approximation tool will insert a specified number of points
and edges evenly spaced on a selected section of a curve or conic. This is
a great tool for introducing problems using the Trapezoidal Method of
integration. (Take a look at our Gx book, Calculus Explorations .)

Here are the steps:

e
1. Click Draw / Curve Approximation @

2. Select any function, circle, ellipse or parabola and drag the cursor
over the curve.

3. In the data entry box type the number of points you want on the arc.

Note: It is best to draw your curve independent of existing points on the
curve. Then connect other geometry to the approximation points. If you
start or finish the arc with points lying on the curve (e.g. point C in the
ellipse above) and later decide to delete the curve approximation,
attached geometry may also get deleted.
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Here is the area of a function using the Trapezoidal Method:

Adding Text to the Drawing

Draw

i o [ [P e
B [ o o
@I=Z

To add titles or other annotation to the drawing follow these steps:

1. From the Draw toolbox click the Text icon E/I or select Text from
the Draw menu.

2. Position the text cursor A at the upper left corner where you would
like your window of text located.

3. Click and drag to form your text box to the appropriate size.
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4. Enter and format your text in the Edit Text dialog.

Enter mathematical statements using the Annotation / Expression tool.

Inserting and Editing Text

In the Edit Text dialog you can enter and format the text that will be
displayed in your defined text window.

Edit Text |

® @ l::l | v Ry ||.ﬁ.rial s =l
=) EEE

Surface Area of
a Sphere]

a|Bly|8lef&m|6)vKk|Ap

Greek Lawer IGreek. Lipper I Annotation I

Ok | Cancel |

The default text formatting for this dialog is set in Edit / Preferences /
Text & Pictures.

Using Pictures in the Drawing

Draw

CDRIRREZG
(Y= b [ 5 o

AE)=S

Liven up your examples with a picture or two, or use an image for
reference points in your drawing. Here's how:
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1. Click the Picture icon @ in the Draw toolbox or select Picture
from the Draw menu.

2. Click and drag the cursor to delimit the area where you want to place
the picture.

3. Find your image in the Select Image File dialog. Image formats
include: .bmp, .gif, .jpg, .pcx, .png, and .tif

4. After entering your images, change to Select .| mode or choose
another Draw command.
Rugby_kick.gx 4

g-x
— arctan| ————
d*+d-g+x"

Angle made by the goalposts (A & B)
at the point of the kick (D). w

4 b

Pictures are always inserted under your drawing objects, so you can add a
picture at any time.

------

The inserted picture can be rotated and the transparency level can be set
in the Display Properties dialog box.

e Right click on a highlighted picture and then select All Properties

e Or select Properties from Edit menu.
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X

Display Properties

B Picture
Finned True
Angle In Degrees (-359 to 359 1]
Transparency (0% ko 100%:) 1]

Ok, | [ Cancel

Adding Expressions

Draw

o x
CIRIRREZEGE
Y= | bt | 5
You can type an algebraic expression in the drawing window and

Geometry Expressions will solve it with whatever information it has
available. Here are the steps:

1. From the Draw toolbox click the Expression icon @ or select
Expression from the Draw menu.

2. Move the expression cursor *7 to the position where you want it to
appear in the drawing window and click to display the data entry box.

3. Enter the expression using numbers, variables, and output expression
names. Use the Symbols toolbox to help you enter mathematics.

Adding an expression to the diagram can help you work out relationships
in the geometry. Here is an example making use of the Expression tool
to see the relationship between similar triangles.
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a
ZD:’
2
a +h
9 Zy 3
e
7 b

1

Sides a and b are perpendicular, and AC is perpendicular to BD. We
obtained the Output of lengths AD and BD using the Show Name button.

The expression to solve is the relationship of the two lengths: Zq / Zq- The
system immediately evaluates the expression as => a/b.

Creating Functions

Draw

i [4 | <|rA e

1. Click the Function icon El in the Draw toolbox or select Function
from the Draw menu

2. Click the drop-down list button to select the function type that you
want to use in your drawing.
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Cartesian Function

Function Type

3

Twpe: | Carkesian o
Y=

Palar
Paramektric

Skark: |

End: |

CIE

] [ Cancel

]

When you select Cartesian from the Function Type dialog, the next line

contains a general form of the function in terms of Y.

Function Type @

] [ Cancel

]

You can define a domain of the function by enter values for Start and End.
If you want to draw function with indefinite domain, leave these fields

blank.

You can define this function in these ways:
e Modify the formula directly:

Function Type

Tvpe: | Cartesian

Y= |a*}<”‘2+l:|*>¢:”‘|

Start: |

End: |

Ik

H Cancel ]

Y=¥"-a+c+h- ¥
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e Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag this handle around the drawing.

Click and drag another place on the function and another moveable
handle appears if there is another variable in the equation.

This feature is a wonderful way to understand exactly how the
equation represents the function.

In the first example, a click of the curve gives you the b handle, the
y-intercept, and lets you drag the function up and down. Click and
drag another place on the curve and you get the a handle to change
the shape of the curve.

5

[% | | L) Variables {31

Variables | Functions

Mame Value Locked
a -0,20542591
b 3.5221638

Notice the Variable toolbox displays the changing values as you
move the handles.

e Modify the function after it's drawn by double clicking the function tag
and changing it in the edit box.

e Modify the domain of the function after it's drawn by double clicking
the curve.
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The Generic Function f(X)

To use the generic form of a function, Y=f(X), select Cartesian from the
Function Type dialog, enter f(X) in the edit window and click OK:

Function Type E

Tvpe: [Zarkesian b

) %

Skark:
End;

[ oK H Cancel ] B/E _4 2 2 4 E B

Click the Functions tab of the Variables toolbox to see the values used
in the function.

You can define this function in these ways:

e Modify the edit line at the bottom of the Functions tab. (Use your
keyboard arrow keys to move through the whole function.)

e Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag a handle around the drawing to
change the curve. Click and drag another place on the curve and
another moveable handle appears if there is another function
variable in the equation. In the general function in this example we
have 5 possible handles: f(a), f(b), f(k), f(u), and f(v).
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Polar Function

Variables | Functions |

Mame Value

f K= fu] +f ] HFR] H{(xF...

| XFI ] +(FTb] +{(-Fa)) ~(2)/(4)) |

| £

When you select Polar from the Function Type dialog, the next line
contains the general form of the function in terms of the radial

coordinate, r and the polar angle, T.

Function Type

Type: | Polar

= |EI*T+|II

Stark: |E

End: |6.28

l

r=T-a+b

Lo

You can define this function in these ways:
Modify the formula and the curve domain directly:

© 2012 Saltire Software



66

Geometry Expressions Manual

Function Type E]
Type: |Polar L
r= a*T3+h
Start: |1 110
I \ ,
[ Ok l [ Cance ] ] 20 10

Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag this handle around the drawing.
Click and drag another place on the function and another moveable
handle appears if there is another variable in the equation.

This feature is a wonderful way to understand exactly how the
equation represents the function.

In the example above, the second click gives you the a handle; click
and drag another place on the curve and you get the b handle to
change the shape of the curve.

r=T -a+h

| ] Variables -

Variables | Functions

Mame Value Locked
a 0.040072655
b 0.31054743

Notice the Variable toolbox displays the changing values as you
move the handles.

Modify the function after it's drawn by double clicking the function
tag.

Modify the domain of the function after it's drawn by double clicking
the curve:

© 2012 Saltire Software



Tools 67

T2\ r=T-a+b

Parametric Function

When you select Parametric from the Function Type dialog, the next
line contains the general form of the function in terms of X and Y and a

parameter, T.
Function Type [$_<|

Tvpe: F'ar‘arnetrin:

W= |a*sin{T]|

#=a-sin(T)
Y=b-cos(T}

Skark: |D

|
Y= |I:|*|:|:15|{T]| |
|
|

End: |10

[ (9] 4 H Zancel ]

You can define this function in these ways:
e Modify the formula and its domain directly:

A
/
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Function Type E]
Twpe: | Parametric w
w= | T-a*sin{T}
y= | Bros(T) 14 %=T-a-sin(T)
Start: [0 19 Y=b-cos(T)
End: |10
[ 2 4 6 8 10

e Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag this handle around the drawing.

Click and drag another place on the function and another moveable
handle appears if there is another variable in the equation.

This feature is a wonderful way to understand exactly how the
equation represents the function.

In the example above, X=T-asin(T), Y=b-cos(T), a click and drag
gives you the b handle, and lets you drag the function up and down.
Click and drag another place on the curve and you get the a handle
to change the shape of the curve.

16 | L] Variables —[?ZCI|
¥=T-a-sin(T)

N=h-cos(])

Variables | Functions

Mame Value Locked
a 1,62983725
b 2.2937335

2 4 6 5 10 12
Notice the Variable toolbox displays the changing values as you
move the handles.

e Modify the function after it's drawn by double clicking the function
tag.

e Modify the domain of the function after it's drawn by double clicking
the curve:
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Function Type rg| F{:T‘a SN T}
1o LY =b-cos(T)
¥= |(bHcos(TI(-1)) re : : : : : h—
Start: -8 |6 -4 -2 2 4 6 8
End: |8 | 1-2
[ OF l[ Zancel ]
1-4

Piecewise Function

A piecewise function or expression can be created using the Piecewise
symbol:

Symbols B
GreekLuwerlGreekngl

o/ Bly)dje|C)n)O]
kA jpjviEjojm
plojtjviéxyv @
- N B @)1

or the built-in function - piecewise({expressionl, domainl},{expression2,
domain2}...,{last expression, otherwise}). The reserved word,
"otherwise" is an option available for the last condition.

Here we show how to enter the sequence of values, followed by
conditions:

e Create a function. E

e Double click the equation
to edit.

— y=}atb
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e From the edit box click T ¢ % v el
the Piecewise icon in TR TN
the Symbols toolbox. VO B B (@ 1BNE
Four small gray boxes
will appear, including the /
one containing the X-a+b
original equation.

e Fill in your piecewise |T|U|4]|'I.|l|f|ﬂ:l|‘

arameters - equations in
t[:)he left columnqand their VO a—ul B, (@] 121) {5
domain in the right 7
column. To expand the
function, click the
Piecewise icon again for
an additional row. A

¥oata x<=-1

2*a -lex==1

a+

Here's the finished piecewise function:

Y= a+}{2-a X
2-a -1=X and X1

atXoa X=1

Piecewise Parametric Example

Any of the functions available in Geometry Expressions can be piecewise,
including parametric functions. Take this square for example.

1. Click the Draw / Function

tool E
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2. Select Parametric from the x|
drop down Type window. Type: [Parametric ]
= Cartesian
Paolar
Start: |
End: |
Ok | Cancel |
3. Enter the first value (side) for x|
the square and the range for Type: [parametri B
the parameter values - - |r
Hit enter. Don't worry about =
the shape of the function, it's Start: |0
not defined yet. End: B
Ok | Cancel

4. Double-click the function and

select the x value [[1]
T
5. Click the Piecewise icon {t3
6. Enter the x values for each g ra—

side of the square. When you
run out of gray boxes, click

the Piecewise icon again to -1 t<=6
get another row. -

3 te=4

T A
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7. Now do the same for the y [?H te=2 |
value, select the T parameter 34 te=d
and click the Piecewise icon 3 !
times - -1 1==6

t-7 t<=8
Use the arrow keys on your T |
keyboard or your mouse to
move to the next gray box.
wL o
t
Here is the function:
(X=[1  T<2)
3T T4
1 T<6
|-7+T T<8
y=[T T=2
2 T4
6-T T<6
. 0 T=8 )

The Selection Arrow

o ®

[ [

(DI =]
AE=EE

When you are finished with the drawing functions, click the selection

......

arrow % to enable other functions or adjust your drawing.

With the arrow, you must first select elements of the drawing in order to
enter constraints and constructions and to output calculations.

Many of the tools require you to select multiple objects.

The Selection arrow is also available form the icon bar at the top of the
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screen.

{® Geometry Expressions
File Edit View Draw Annotate Constrain (Input) Construct Caloulate (Qutput) Help

@eoL s +3EE6

{ " Lemniscate.gx | {  Clrde squeeze.gx

Selecting Multiple Objects

Many of the Constrain, Construct, and Calculate tools require that you
select more than one object.

To select more than one object:

e Click the selection arrow D" on the tool bar.
e Hold down the CTRL or SHIFT key as you click the objects you want to
select.

If you click the wrong object while holding down the CTRL key, click it
again and it will become unselected.

If all of the objects you wish to select fall within a rectangular region, you
can use the selection box:

......

e Click on the selection arrow i on the tool bar or the Drawing

toolbox.

e Draw a rectangle around all of the objects by clicking and dragging.

If you are using Geometry Expressions on a Smartboard, turn on
Smartboard mode to make multiple selections without using the Ctr/ or
Shift keys. In this mode selections accumulate. Clicking a blank space in
the drawing does not clear the selections. Clicking on an item a second
time unselects only that item.
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Smartboard Mode

To turn on the Smartboard mode select Edit / Preferences / Selection;

in the Selection group set Smartboard mode to True.

Transparency (0% ko 100940 40

I_._I Transparency (0% ko 100%:) 40
Grid, Axis, Page Bl Selection
Line Calor B Gray
Line Style Solid
Line Thickness z

False

l True

When set to True, selections accumulate until you click a command.
Clicking a selected item a second time unselects that item, but any other
selected items stay selected. To clear all the selections, select Clear
Selection under the Edit menu or click all the selected objects again.

Adjusting the Drawing

......

bar, to move, rotate or delete selected object(s) in the drawing.

You can change a constraint value, annotation or label by double clicking
it, retyping the value or variable and then pressing the enter key.

The Scale, Zoom and Move / Pan functions have a mouse shortcut:

e The scroll wheel on your mouse can be used to Scale the drawing up
or down. Hold down the ctrl key while moving the wheel and the

operation becomes a Zoom.

e Right-click and drag the mouse anywhere in the drawing window to

Move or Pan.

------

you select %! or choose another mode (e.g. any Draw tool).
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Constraints

Using Drawing Constraints

Conskrain (Input) q x
F F F Fi F Fi F

A D 2 N\ TP Ly
After sketching the geometry of a problem, constrain it with
measurements, coordinates and implicit equations in real or symbolic
terms. The drawing responds automatically to the assigned input

constraints. Geometry Expressions will automatically add any constraints
you leave out.

L
Since annotations may look identical to constraints, use the icon, , to
Distinguish Constraints / Annotations. The icon is a toggle; to turn off
the marks, click it again.

Initially, all the constraints in the toolbox are inactive. You must first
select the parts for your drawing that will be constrained. Constraint
choices are listed below along with the drawing elements that must be
preselected. Be careful when selecting geometry objects, if extra things
are selected that are not related to the constraint (like other constraints)
the constraints will remain inactive. This can happen by mistake,
especially when using the selection box tool.

Constraint Preselected Objects
£ Distance / Length Two of any combination of points,
lines, line segments, vectors, or
polygon sides.
’@ Radius A circle
8 Perpendicular Two of any lines, segments,

vectors, or polygon sides.
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]

R R

Angle

Direction

Slope

Coordinate

Coefficients

Tangent

Incident

Congruent

Parallel

Implicit Equation

Point Proportional
Along Curve

Two of any lines, segments,
vectors, or polygon sides.

A line, segment, vector, or polygon
side.

A line, segment, vector, or polygon
side.

A point
A vector

A circle or locus and a line,
segment, vector, or polygon side.

A point and a line, segment, vector,
polygon side, circle or locus.

Two or three of any line segment,
vector, or polygon side.

Two or three of any line segment,
vector, or polygon side.

A circle, line, segment, vector, or
polygon side.

A point and a line, segment, vector,
polygon side, or locus

Occasionally you may try to add too many constraints to the geometry,
causing a conflict. The system will help you correct this problem in the

Resolve Constraint Conflict dialog.

© 2012 Saltire Software



Tools 77

Changing a Constraint

To change a constraint, double click it with the selection arrow, L3 retype

the value or variable and press the enter key.
B

o

Distinguishing Constraints from Annotations

Your drawing is defined by Constraints on geometry elements.
Annotations are like labels and have no influence on the geometry
measurements. The original default settings (Preferences / Math) fix
Constraint lines and text in blue and Annotation lines and text in black.
To further distinguish these use the Distinguish Constraints /

o
Annotations A toggle button on the main icon bar.

g
When active, the button is highlighted - A , and a 3 s placed next to

all constraints and a * is placed next to all annotations.
As with all toggles, you can turn these marks off with another click of the

B
A button.
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System Added Constraints

In Geometry Expressions, you do not need to fully constrain your model.
Any parameters you have left unconstrained are filled in by the geometry
engine.

For example, the following drawing is constrained only modulo a rigid
transformation (typical for many geometry problems).

C

So if you ask for the coordinates of any of the points, they will be given in
terms of system added variables:
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— (ufb-caa(ﬂn)vfb-sin @D)j
C

2b

. [our \ﬁa+b+c-\h+b—c-\h—b+c-\}a+b+c-5in@nj )

Clearly the system has added variables for the location of point A, and for
the direction of line AB.

To display these variables, check the default setting, Show System
Variables, found in the Edit / Preferences menu selection on the Math

page (left panel) under Output.
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Preferences |Z|
R Math properties
Selection Font 10; Swiss; Arial; Mormal; Normal; Mot Underling ~
Line Equation Style ax+by+c=0
E Constrain (Input)
Eh. Line Color [ (130,130,255)
Geometry Line Style Solid
ARC Line Thickness 1
;:‘;ﬁ_.‘ Font 10; Swiss; Arial; Mormal; Normal; Mot Underline
E‘ B Expression
Text & Pictures Font 10; Swiss; Arial; Mormal; Mormal; Mot Underline

Pinned False
% E Math
> XI Angle Mode Radians

Math Intermediate Variable Complexity (2 to 100) 15
Precision Type Significant Figures
Decimal Digits (0 ta 8) 8 Digits
B Output

Grid, Axis, Page Use Assumptions False
Lze Intermediate Variables False
Show Intermediate Variables True
Show Mame True

Show System Variables True -

Maximum Size Allowed On Diagram False =

Ok | Cancel |

When the setting is True, you will see the system variables when you
select the output:
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—, (un+b-cos(ﬁ@,vfb-sin(ﬁ@j
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Constraint Conflicts

If you enter a constraint for some geometry which is already constrained
by another constrained object you will see a message like the one below.

The new coordinate constraint kries ko move ikems that are
already fixed by other constraints,

(%) Discard the coordinate

i) Calculate the coordinate From other constraints

) Relax other constraints so the coordinate is independent
Click on the constrainks to be relaxed
Conflicking Constrainks: 0

Constraints Relaxed: 1

The coordinate to be added

[ (04 ][ Zancel ][ Help ]

In this case, the Coordinate constraint was already determined by the
other two sides and an angle constraint on the triangle. There are three
ways of dealing with this problem:

1. Hit the Cancel button to leave the drawing as it was without the new
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constraint.

. Click the first button, "Calculate the coordinates from other

constraints" (the default choice). This is similar to the first choice, it
eliminates the new constraint, but also calculates the selected
geometry’s value. In this case, the coordinates of point C would be
calculated and displayed.

. If you choose "Relax other constraints so the coordinate is

independent", this will keep the new constraint you just entered and
allow you to eliminate one of the red highlighted constraints (figure 1).
When you select one of these constraints (in figure 2 below we clicked
on 0), the highlight changes to gray. After you click Ok, the selected
constraint, the angle 0 in this case, is calculated and displayed (figure
3).

12
B
[
| ket
1 t
z
I 2 3 C4

Figure 1

Figure 2
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Figure 3
Distance / Length Constraint
Conskrain (Input) q x

SCEIREIEL N

D L\ Ty

The Distance / Length constraint lets you specify the following
dimensions:

e Length of a line segment, vector, or polygon side

e Distance between two points or a point and any one of the line types
listed above.

e To enter a constraint:

------

£
selection, the Distance / Length icon will light up l'j__l .

2. Click the icon, enter the constraint value, either real or symbolic,
and press enter. You can press enter without typing a value to
accept the system's default value.

You can click the constraint and drag it to adjust its placement on the
drawing.
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Radius Constraint

Conskrain (Input) q x

_®3d%%ﬁ
AD LA F XY

To specify the radius of a circle:

------

1. From select mode %1 click the circle. The circle will be highlighted as

;
well as the icon G .

2. Click the Radius icon, enter the constraint value, either real or
symbolic, and press enter. You can press enter without typing a value
to let the system insert a variable name.

You can click the constraint and drag it to adjust its placement on the
drawing.
Perpendicular Constraint

Conskrain (Input) q x

.ﬁb’@@ﬁ TR N
2D 2N\ Iy

Any two of lines, segments, vectors or polygon sides can be constrained to
be perpendicular with these steps:

------

1. Select L% two from the line types listed above.

:&
2. Click the Perpendicular icon —‘L .

The lines are redrawn and the perpendicular constraint is attached.
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Angle Constraint

Conskrain (Input) q x
&I QB g ';‘—"—% '.:;'..ﬂ

F F F F Fi F

A D e 2\ TP Ly
Any two of lines, segments, vectors or polygon sides can be constrained
with an angle value or variable name with these steps:

------

1. Select L% two from the line types listed above.

Fi
E
2. Click the Angle icon -d :

3. Enter the constraint, real or symbolic. If you enter a real value, the
lines will be adjusted to reflect the constraint.

Which Side to Constrain?

Sometimes when identifying angles, the constraint falls on the wrong one.
In the example below, we wanted BDC, not BDA. Just click the cursor
over the constraint arrow and drag it to the other side, then release the
mouse button - done!

B B
i ; .: :IC ‘C
A A
D D

Note: The angular units are displayed in the lower right of the screen.
Change the default Angle Mode in the Edit / Preferences / Math
Properties menu, Math settings group.
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Direction Constraint

Conskrain (Input) q x
25 B 3L 34CARS 2
D 2N\ FHKy

Constrain any of the line types; line, line segment, vector, or polygon side,
to a direction measured from the horizontal.

------

F
2. Click the Direction icon ‘/JA- .

3. Enter the constraint, real or symbolic. If you enter a real value, the
line will be adjusted to reflect the constraint.

Note: The angular units are displayed in the lower right of the screen.
Change the default (Degrees or Radians) in the Edit / Preferences
menu.

Slope Constraint

Conskrain (Input) q x
2,90 UK,
D LNy
Specify a slope for any of the line types; line, line segment, vector, or
polygon side.

------

Fi
2. Click the Slope icon if .

3. Enter the constraint, real or symbolic. If you enter a real value, the
line will be adjusted to reflect the constraint.
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Coordinate Constraint

Conskrain (Inpuk) I x
DAL UK UG)
A D L2 F

You can give coordinates to any point in your drawing:

------

1. Select ! .Ff.; a point.

ri
2. Click the Coordinate icon ¥,

3. Enter the constraint, real or symbolic. If you enter a real value, the
line will be adjusted to reflect the constraint, even if the coordinate
axes are not displayed.

To change the coordinates shown, double click and type over the
highlighted value in the data entry box.

Constraining Vector Coeffecients

Conskrain (Input) q x

— G!:L—C\ ‘}‘—{"%(—Lﬂ
@ D2 NKK

You can specify coefficients for a vector with the following steps:

------

1. Select .Ff.; a vector.

2. Click the coefficients icon "@-'

3. Enter the coefficients separated by a comma.

Note: Don't forget the parentheses or an error message appears.
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Tangent Constraint

Conskrain (Input) q x

%EH%%%%
D) 2 7 7 1

Any of the line types; line, line segment, vector, or polygon side can be
made tangent to a circle or locus with these steps:

------

F
2. Click the Tangent icon Q from the Constrain tool box or select
Tangent from the Constrain menu.

The line and curve immediately become tangent.

Incident Constraint

Conskrain (Input) q x
ORI R
o DAL ¥ 7 1

Constrain a point to be incident to any other geometry; line, segment,
vector, polygon side, circle or locus with these steps:

------

1. Select L% the point and the other geometry listed above.

Fi
2. Click the Incident icon -‘jﬂr from the Constrain toolbox, or select
Incident from the Constrain menu.

The point is moved to meet the line or curve, or the extension of the line.

Below is an example of the latter, point D is moved to lie on the extension
of line segment AB.
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C

If you select the point or the line, incidence is indicated by a bowtie
around the point:

Congruent Constraint

Conskrain (Input] o x
B URUA

%D L% x4
Constrain two or three of any of these geometry types: line segments,
vectors, or polygon sides, to be congruent with these steps:

------

1. Select L% two line segments.

£
2. Click the Congruent icon from the Constrain toolbox, or select
Congruent from the Constrain menu.
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You will see matching congruency lines on the selected segments and a
length will be adjusted.

Parallel Constraint

Conskrain (Input) q x
SRCEI LT
A D 2 NZI?E Ly

Any two or three of the linear geometry types can be made parallel: line,
segment, vector, or polygon side.

------

1. Select L% two or three from the types listed above.
Fi

2. Click the Parallel icon from the Constrain toolbox, or select
Parallel from the Constrain menu.

The geometry will be adjusted and matching symbols

*;’_’/,-"

appear on the selected lines.
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Implicit Equation Constraint

Conskrain (Input) q x
R IR
%D L9

You can use symbolic variables to constrain geometry with an implicit
equation. Lines, line segments, polygon sides, vectors and circles and
conics can all be constrained with implicit equations.

------

Fi

2. Click the Implicit Equation icon 7™ from the Constrain toolbox, or
select Implicit Equation from the Constrain menu.

An input window will open next to the geometry you selected. Highlighted
in the window is a generic equation for the selected object; for a line, an
equation like - XA{+YBy+Cy =0 might appear. You can edit the equation

with different variable names or coefficients as you like. You will find these
variables added to the variable list in the Variables toolbox.

Point Proportional Along a Curve Constraint

Conskrain (Input) q x
R CEIR L L
%D 2N % UL
A point proportion t along a curve is defined variously for different types of
curves as follows:

e For a Line segment AB, it defines the point (1-t)-A + t-B

e For a Circle it defines the point on the circle which subtends angle t at
the center.

e For a Locus or envelope, it defines the point at parameter value t.

e For general Cartesian functions, it defines the x value of the point on
the function.
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e For Polar functions, it defines the point on the function which
subtends angle t.

e For general Parametric functions, it defines the point at parameter
value t.

e For an Ellipse of the form X2/a2 + Y2/b2 =1 it defines the point (a cos(
t), b sin(t)).

e For a Parabola of the form Y=X?/4a it defines the point (2at, at?)

e For a Hyperbola of the form X2?/a? - Y2/b2 =1 it defines the point (a/
cos(t), (b sin(t))/cos(t)).

1. Select %] a point and one of the curves mentioned above.

Fi
2. Click the Point Proportional icon :f'—'l from the Constrain
toolbox, or select Point Proportional from the Constrain menu.

3. Enter the parameter or quantity (symbolic or real) in the data entry
box.

For example, in the following diagram, D is defined proportion t along AB,
and E is defined proportion t along BC. The curve is the locus of F as t
varies between 0 and 1.

© 2012 Saltire Software



Tools

93

xn—2-t-xn+t2-xn+t-x1—t2-x1+t2-x2 yD—E-t-yn+t2-yn+t-y1—tz-y1+t2-y2

=

1-t+t° 1-t+t2

In the following example, the curve is the locus of the point (x,x2).
Tangents are created at points with parameter values x, and x; on this

curve.
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Where is Point proportional along curve for conics?

The best way to understand the location of Point proportional along
curve command for conics is to see how we construct it geometrically for
each conic:

Ellipse

The ellipse with foci A and B is inscribed in circle, center M. Draw the
radius MN at angle t to the major axis and drop the segment NO
perpendicular to the major axis of the ellipse. When the intersection of
NO with the ellipse (point C) is constrained to be t proportional along the
ellipse, it's coordinates will be (a cos(t), b sin(t)).
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a-cos(t).b-sin(t)
A

Parabola

C lies on the parabola and BC is perpendicular to the axis AB of the
parabola. Point D is located proportion t along the segment. Point F is the
intersection of the perpendicular to BC through D with the parabola. It
has the coordinates (2at, at?) when it is constrained to parametric
location t on this parabola.

14 12 A0 & - R 1R

Hyperbola

CD is the perpendicular projection of C onto the axis of the hyperbola, GF
is the circle centered at the center of the hyperbola which goes through
the intersections of the hyperbola with its axis. H is the point of contact of
this circle with the tangent from D. We can see that the angle DGH is the
same as the parameter value. When point C is constrained to be at
parametric location t along the curve, its coordinates are (a/cos(t), b sin(t
)/cos(t)) on this hyperbola.
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a b-sinft)
—. | cosit)

cos(t)

| a=0 | b=0

o —

Constructions

Creating Constructions

Conskruck X

LAAANLUNY
QL DGR

After sketching and constraining your drawing there are a whole set of
constructions that can be applied to the geometry. First you must select
the geometry elements which pertain to the construction. When you select
the geometry the appropriate constructions will be highlighted.

The following table lists the Constructions, their icons, and which
elements must be preselected to activate the constructions. Be careful
when selecting geometry objects, if extra things are selected that are not
related to the construction, the construction icons will remain inactive.
This can happen by mistake, especially when using the selection box tool.
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Construction

Midpoint

Intersection

B

Perpendicular
Bisector

Angle Bisector
Parallel
Perpendicular
Tangent

Polygon

Reflection

Translation

Rotation

Dilation

NSRRI S

Locus

vy

Preselected Objects

A line segment, vector, or polygon side.

Two of: a line, segment, vector, polygon
side or conic. Conics are limited to
intersecting only with lines, segments and
vectors.

A line segment, vector, or polygon side.

Two of: a line, segment, vector, or
polygon side.

A point and one of: a line, segment,
vector, or polygon side.

A point and one of: a line, segment,
vector, or polygon side.

A circle or curve, and optionally, a point
on the curve

Three or more connected line segments or
points (vertices) to form a polygon

One or more objects
One or more objects
One or more objects
One or more objects

A point or line that will vary with a
parameter
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ﬂ Trace One or more objects that will vary with a
T parameter

Area Under Arc An arc of a Cartesian function

Midpoints of Line Segments

Conskruck X

(U AN ¥
VOGN

You can construct a midpoint on any line segment, vector, polygon side, or
between two points by:

------

1. Select L% two from the geometry types listed above.

2. Click the Midpoint tool =, or select Midpoint from the Construct
menu.

A point will appear in the middle of the selected line.

Intersections

Conskruck X

AN WA Z2iN e
@0V DG LA

You can construct a point of intersection between any of the line types in
your geometry; line, segment, vector, polygon side or circle. You can also

construct intersections of circles. Conics are limited to intersections only
with lines, segments or vectors.

------

1. Select L% two from the line types listed above.

il
2. Click the Intersection tool or select Intersection from the
Construct menu.
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A new point and label will appear at the intersection. If the lines are
segments that do not intersect, a point will be created at the extension of
the lines as with line segments AB and CD below.

B

C g——n D

t

If the geometry will never intersect, the selected objects are moved to
form the intersection. In the example below, the infinite line and circle
become tangent at the newly created point, H.

oy o

Conskruck X

04V VG 2N

You can construct a perpendicular bisector on any line, segment, vector,
or polygon side with these steps:

------

Perpendicular Bisector

2. Click the Perpendicular Bisector tool ﬂ- or select Perpendicular
Bisector from the Construct menu.

An infinite line will appear at right angles to the selected line.
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Angle Bisector

Canstruck ox
LA4AKg 7
4V OGN

You can bisect the angle between any combination of line types; line,
segment, vector, or polygon side with these steps:

------

1. Select (%1 two of any of the line types listed above.

2. Click the Angle Bisector tool ﬂ or select Angle Bisector from the
Construct menu.

An infinite line will appear between the two selected lines. You can use
the Calculate / Angle tool to get the value of the bisected angle.

Parallel Constructions

Conskruck X

.44 4 Va
0L DGRA

You can construct a line, through a point, and parallel to another line,
segment, polygon side or vector with these steps:

------

2. Click the Parallel tool :?/ or select Parallel from the Construct
menu.

A line is constructed which is parallel to the selected line and passes
through the selected point.
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Perpendicular Constructions

Conskruck 0 x

A IRIRAY 7 Y,
QLGSR

You can construct a line, through a point, which is perpendicular to
another line, segment, polygon side or vector with these steps:

------

/]
2. Click the Perpendicular tool or select Perpendicular from the
Construct menu.

A line is constructed which is perpendicular to the selected line and passes
through the selected point.

Tangents

LUANLNY
4L VGLRA

You can construct a line that is tangent to a circle or curve with these
steps:

------

1. Select L% the circle or curve. You can also select a point on the curve
so that the tangent goes through the point on the curve.

v/
2. Click the Tangent tool /l/ or select Tangent from the Construct
menu.

A line tangent to the selected curve will appear at the point where you
selected the circle or curve, or at the selected point.
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Polygon Construction

Conskruck 0 x

LU ALy
@GV V%A

If you created a polygon with the line segment tool, or your polygon was
not shaded for some reason, (e.g. the drawing of the sides was
interrupted or out of order) you can make joined line segments into a
polygon that can be selected with a single click using this construction.

------

1. Select (%1 the line segments that make up the polygon.

2. Click the Polygon tool /' in the Construct toolbox, or select
Polygon from the Construct menu.

The polygon will be filled and you can now select the entire polygon with a
single click.

Reflection

Conskruck

AAL 7
)4 &G0 P

------

2. Click the Reflection tool ﬂ" in the Construct toolbox, or select
Reflection from the Construct menu.

3. Either click the cursor to place the reflection line on the screen, adjust
the angle and click again, or select an existing line as the reflection
line.

A copy of your selected geometry will appear on the other side of the
reflection line.
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Notice all points on the reflected geometry are written as "prime", i.e. A
becomes A'. If you reflect the geometry again, A' becomes A".

Translation

LU ANgi\y
24DV G2 A

You can translate any subset of your diagram with a translation vector.
Here are the steps:

------

1. Select L% the geometry to be translated.

2. Click the Translation tool ﬂ in the Construct toolbox, or select
Translation from the Construct menu.

3. Click the cursor to draw the end point of your translation vector and
move the cursor to establish the length and angle of the translation.
Click again to finish the vector.

The translated geometry appears. You can adjust the position of the
translation by clicking and dragging the tip of the vector.

Notice all points on the translated geometry are written as "prime", i.e. A
becomes A'. If you translate this geometry again, A' becomes A".

Rotation

LU ALy
@4 NDfe e A

You can rotate any subset of your diagram about a point. Here are the
steps:
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------

1. Select L% the geometry to be rotated.

2. Click the Rotation tool ﬂ in the Construct toolbox, or select
Rotation from the Construct menu.
3. Click the screen to place your rotation point.

4. In the data entry box presented, enter the angle of rotation.

The rotation of the selected geometry appears.

Notice all points on the rotated geometry are written as "prime", i.e. A
becomes A'. If you rotate this geometry again, A' becomes A".

Dilation

Conskruck X

LAANLIY
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You can dilate any subset of your diagram from a point. Here are the
steps:

------

1. Select %1 the geometry to be dilated.

2. Click the Dilation tool @ in the Construct toolbox, or select
Dilation from the Construct menu.
3. Click the cursor on your dilation point.

4. In the data entry box presented, enter the dilation factor.

The dilated geometry appears.

Notice all points on the dilated geometry are written as "prime", ji.e. A
becomes A'. If you dilate this geometry again, A' becomes A".
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Locus of Points / Envelope

Conskruck 0 x

LA L NGAY

You can construct a locus of points or envelope from a selected point or
line, by defining a range for some constraint in the drawing. Just follow

these easy steps:

------

1. Select . [* the point on the drawing that will form the locus (point B in
the example below); select a line, line segment, or vector to form an
envelope.

7,
2. When you click the Locus icon d , the Edit Locus dialog pops up.

Edit Locus E|
Pararnekric Yariable |t A
Skart Walue S
End Yalue 1.5

[ (94 l [ Cancel ]

3. You need a parameter to drive the motion to create the locus. Click
the arrow key to the right of the Parametric Variable window to
select from a list of all variables in the drawing. (If you entered the
needed constraint in real terms, Cancel the trace and change the
constraint to a variable by double-clicking it in the drawing window.)

Edit Locus §|

Parametric Wariable

Skart Walue

End Yalue

[ ok H Cancel ]

4. Simply fill in the values for the appropriate variable and click the Ok
button.
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@ Note: The locus only works if the figure's position is fixed i.e. a point in
a triangle will not work as a locus unless the location of the other two
points are fixed with coordinate constraints.

To adjust the range of the locus, double-click the locus to edit the dialog.

The following example shows an envelope of the line DE. We use the Point
proportional along curve constraint and the parameter t to position the
points D and E (D is (1-t) along line AC and E is t along line AB). In the
Edit Locus dialog, we create the envelope from parameter t as it ranges
from O to 1.
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You can replay the creation of the envelope with the Animation tools.
Select variable t and click the Play button.

Trace

Conskruck 0 x
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You can Trace the movement of one or a group of drawing objects. You

can create string art drawings and see how an envelope curve is formed.
Here are the steps:

------

1. Select L% the drawing objects to be traced.

2. Click the Trace tool ﬂ and the Edit Trace dialog pops up.

3. You need a parameter to drive the motion of the trace. Click the
arrow key to the right of the Parametric Variable window to select
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from a list of all variables in the drawing. (If you entered the needed
constraint in real terms, Cancel the trace and change your constraint
to a variable by double- cIicking it in the drawing window.)

Parametric Yariable |_ A | Parametric Yariable |t

Start Walue 014357171676 | | start valee :

End Yalue |5 | End Yalue _

Count L || count L |
[ oK ][ Cancel ] [ oK ][ Cancel ]

4. Simply fill in the values for the appropriate variable and click the OK
button.

(-a.0) (a,0)

To adjust the range or number of traces, double-click one of the traces to
edit the dialog.
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Area Under the Arc

The Area Under Arc function is found only in the Construct menu at the
top of the main window. Here are the steps:

1. Select an arc drawn over a function.

2. Select Construct / Area Under Arc.

A filled area is created between the arc and the X axis. The necessary
lines and points containing the area are automatically added.

14
Trace
Area Under Arc /
K 5
12
YEX g+b :
2 4

This is a great way to illustrate the definite integral.

Integral Calculus

The Area Under Arc function is a great way to show problems with the
definite integral.

Here are the steps for making the integral of the generic function f(x) over
the interval o to B:

1. Select the Draw / Function tool and enter f(x) in the Y= data entry
box. Click OK.

© 2012 Saltire Software



110 Geometry Expressions Manual

2. Use the Draw / Arc tool to trace over some portion of the function.

3. Select the new arc - be careful not to select the whole function. Just
the section of arc should be highlighted.

4. Choose Area Under Arc from the Construct menu. The area
between the arc and the X axis will be filled.

5. For each endpoint of the arc, use the Constrain / Point
proportional along curve tool to define the limits of the region, e.g.
select a and B from the Symbols toolbox.

6. Select the area under the arc and click Calculate / Symbolic /
Area.

Annotations

Applying Annotations

Annotations allow you to add constraint information to your drawing which
isn't needed for it's construction. These might be constraints that cause
the geometry to be over constrained, but you might want to give the
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viewer some additional information. This feature can be very helpful for
making up texts or worksheets.

Annotate tools are similar to Text in that they have no influence on the
geometry engine, even though they are placed exactly like the Constrain
tools.

Since annotations may look identical to constraints, use the icon from icon

a6
bar A at the top of the window to Distinguish Constraints /
Annotations. The icon is a toggle; to turn off the marks, click it again.

The Symbols and Annotation Symbols toolboxes are both available to
the Annotate tools.

Here are the Annotate tools and the object(s) to preselect:

Annotation Preselected Object(s)

H Distance / Length| A line segment, vector, or polygon side, or
a point and one of these line types
(perpendicular distance), or two points.

t@ Radius Circle

Al Perpendicular Two of any line, segment, vector, or
- polygon side.

.jd Angle Two of any line, segment, vector, or
- polygon side.

% Direction A line, segment, vector, or polygon side.
% Slope A line, segment, vector, or polygon side.
.is.ﬂ Coordinates Point

.5@', Coefficients Vector

ﬂ Congruent A line, segment, vector, or polygon side.
‘ii!l Congruent Angle | Two of any lines, segments, vectors, or

polygon sides
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% Parallel A line, segment, vector, or polygon side.
’A_f Expression [none]

Distance / Length Annotation

Annokate

Length annotations may be applied to any line, segment, polygon side or
vector. Distance annotations are available between two points, or the
perpendicular distance between a point and a line, segment, polygon side,
or vector. Use these steps:

------

described above. When you make your selection, the drawing
objects will be highlighted and the Distance / Length icon will light

up B
2. Click the icon

3. Enter the distance information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Radius Annotation

Annokate

'.@'. MMM A,
4 2\ 244 47 A5

To annotate a circle's radius use these steps:
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------

and the circle will be highlighted.
2. Click the icon

3. Enter the radius information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Perpendicular Annotation

E .. @ %— M ’ti'm
A\ A M A

The perpendicular annotation inserts the perpendicular mark between any

two of these line types: line, segment, polygon side or vector. Use these
steps:

......

1.Select L% two of any line, segment, vector, or polygon side. The

A
Annotate / Perpendicular icon :‘J will light up when both lines are
highlighted.

2.Click the icon.

K

Note: Placing this annotation between two lines does not change the
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relative position of the lines or prevent the lines from changing their
relative position as it does with the Constrain tool of the same name.

This annotation is very useful if you are displaying a 3-d object. In this
example we imported the Triangular Prism from the Solids folder in the
Figure Gallery.

Angle Annotation

1. Select (%1 two of any line, segment, vector, or polygon side. The

J%
Annotate / Angle icon g‘ will light up and the lines will be
highlighted.

2. Click the icon

3. Enter the angle information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

Which Side to Annotate?

Sometimes when identifying angles, the annotation falls on the wrong one.
In the example below, we wanted BDC, not BDA. Just click the cursor
over the annotation arrow and drag it to the other side, then release the
mouse button - done!
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A A
D

Direction Annotation

2\ A b s

To annotate a line's direction use these steps:

------

1. Select © L\* a line, segment, vector, or polygon side. The Annotate /
Direction icon ﬂ will light up and the line will be highlighted.
2. Click the icon

3. Enter the direction information. There are no format restrictions.
You can use Symbols and Annotation Symbols in the entry. Press
enter when you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Slope Annotation

A AL A4/
o0 A\ A4 3 As

To annotate a line's slope use these steps:

------

1. Select ¢ [* a line, segment, vector, or polygon side. The Annotate /
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Slope icon M will light up and the line will be highlighted.
2. Click the icon

3. Enter the slope information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Coordinate Annotation

Annotate £
o ALY A(E)
X A Ad o Ay &

To annotate an point's coordinates use these steps:

------

and the point will be highlighted.
2. Click the icon

3. Enter the coordinate information. There are no format restrictions.
You can use Symbols and Annotation Symbols in the entry. Press
enter when you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Coefficients Annotation

Annotate

AL AL AR A B,
RN Ad A

To annotate a vector's coefficients use these steps:
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------

up and the vector will be highlighted.
2. Click the icon

3. Enter the vector's coefficients. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

B

+
Ug*u,

0

A

You can click the annotation and drag it to adjust its placement in the
drawing.

Congruent Annotation

Annotate

®=ﬂ .%A% |

Place a congruent mark on any of the linear drawing elements: lines,
segments, vectors, or polygon sides. Use these steps:

------

1.Select L& any line, segment, vector, or polygon side. The
A
Annotate / Congruent icon Awill light up when both lines are
highlighted.
2.Click the icon.
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Note: Placing this annotation on lines does not change the relative lengths
of the lines or keep them the same length as it does with the Constrain
tool of the same name.

Congruent Angle Annotation

Annotate

A9 AL AR A,

AR A @ Ax

Place a congruent mark between pairs of linear drawing elements: lines,
segments, vectors, or polygon sides. Use these steps:

------

Ay |
Annotate / Congruent Angle icon will light up when both lines
are highlighted.

2.Click the icon.
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You can change the arc count with these steps:
1. Select the annotation.
2. Right click to invoke the selection Context menu.

3. Select Tic/Arc Count from the menu and click the desired
number.

Cut
e Copy

Copy As
Send to Mathematica

\\ Paste

Delete
Hide Ctri+H

-

h

Arrange

O~  Congruence Style
Line Properties
Show Arrowheads
Show Symbal
Text Properties

Ticfarc Count

&ll Properties... -

B Y Y ¥ ¥ v

LW QRS R I B O B
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Parallel Annotation

Annokate

Place a parallel mark on any of the linear drawing elements: lines,
segments, vectors, or polygon sides. Use these steps:

------

Annotate / Perpendicular icon % will light up when both lines are
highlighted.

2. Click the icon.

Note: Placing this annotation on lines does not change the relative
position of the lines or prevent the lines from changing their relative
position as it does with the Constrain tool of the same name.

Expression Annotation

A DAL A A,
4 A\ A4 4P

The Annotate / Expression command is useful for placing a line of
mathematics anywhere in your drawing.
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Ax
1. Click the icon ’_?

2. Move the cursor to the position where you want to place the
expression and click.

3. Enter the expression. There are no format restrictions. You can use
Symbols and Annotation Symbols in the entry. Press enter when
you're done.

You can click the annotation box and drag it to adjust its placement in the
drawing.

Calculations

Calculating the Output

Calculake (Oukpuk) R x| | Calculake (QukpUE) o x
Symbolic | peal Syml:-nlic;

D UK K, 2 DUKI A,
OB FEF DVORPEF

Geometry Expressions will make calculations in the geometry based on
any constraints or constructions you have specified, or just from the
sketch. Calculations can be output in Real or Symbolic terms by choosing
the appropriate tab.

If you haven't supplied all of the necessary input constraints, the system
inserts any missing variables automatically or, for real calculations, bases
the value on the sketch.

Some calculations may take longer than you expected. If the calculation
isn't immediate, you can stop it and restart it with these buttons on the
tool bar.

o
“B stop calculations

2
'1_“

Start calculations.
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You may want to reconsider the problem, add constraints, or just let it

continue with the calculation.

The Stop calculations and Start calculations can also be found under
Calculate (Output) menu and under the general context menu.

The table below lists all the available calculations and geometry elements
which must be preselected. Be careful when selecting geometry objects, if
extra things are selected that are not related to the calculation (like other
calculations) the calculations will remain inactive. This can happen by
mistake, especially when using the selection rectangle.

e

0B
L%
2L

X| B88
Y

* %
rok
3 0

Calculation

Distance /
Length

Radius

Angle

Direction

Slope

Coordinates

Area

Perimeter

Coefficients

Parametric
Equation

Preselected Object(s)

A line segment, vector, or polygon side,
or a point and one of these line types
(perpendicular distance), or two points.

Circle
Two of any line, segment, vector, or
polygon side.

A line, segment, vector, or polygon
side.

A line, segment, vector, or polygon
side.

Point

Circle or polygon

Circle or polygon

Vector

A line, segment, vector, polygon side,
circle, or a constructed locus.
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%‘J;: %EJ: Implicit Equation | A line, segment, vector, polygon side,
circle, or a constructed locus.

Distance / Length Calculation

Calculake (Oukpuk) R x| | Calculake (QukpUE) o x
Symbolic | peal Symbolic [ Real

f:Hi;"fH ﬂe%ajum
'@ﬁﬁﬁ @ DR PE

Length calculations may be obtained for any line segment, polygon side or
vector. Distance calculations are available between two points, or the
perpendicular distance between a point and a line, segment, polygon side,
or vector. Use these steps:

------

1. Select ! .Ff.; the line segment, or point and line, or pair of points as
described above.

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Distance / Length tool in the Calculate toolbox or select
Distance / Length from the Calculate menu.

Geometry Expressions displays the length, using any relevant parameters
you may have specified.

Radius Calculation

Calculate (Oukbpuk) x| | Calculake (QukpUt) X

Syml:u:ulu: Real

2N L H G,
ol K %@%ﬂf

Geometry Expressions will calculate the radius of any circle. Use these
steps to find the radius:

&4

.
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------

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Radius tool in the Calculate toolbox or select Radius from
the Calculate menu.

The equation with real or symbolic terms appears in the diagram.

Angle Calculation

Calculake (Oukpuk) R x| | Calculake (QukpUE) o x
Symbolic | pegl Symbalic R' ......

LEdL oy, || elE)K s,
» R0 EE %A PR

Geometry Expressions will calculate any angle between lines in the
geometry. Use these steps to find the angle:

------

1. Select L% two line types - any line, segment, vector, or polygon side.

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Angle tool in the Calculate toolbox or select Angle from
the Calculate menu.

The equation with real or symbolic terms appears in the diagram.
You can obtain the angle's supplement by dragging the angle symbol.

Supplementary Angles

If it's unclear whether a calculation is requested for the angle or its
supplement, you can drag the angle symbol to the correct position.

Here are some examples of playing around with supplementary angles
(inputs, outputs and angle annotations all have this feature):
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Select and drag to get the supplement angle

= 10

drag the input B the output changes
automatically
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Direction Calculation

Calculate (Oukbpuk) x| | Calculake (QukpUt) X
Symbolic | peal
x| X X] X
é @ d q_ilsb

L R”ka )

Geometry Expressions will calculate the direction of lines, segments,
polygon sides, or vectors with these steps:

------

1. Select i a line type.

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Direction tool in the Calculate toolbox or select Direction
from the Calculate menu.

The direction measurement appears in real or symbolic terms.

Slope Calculation

Calculate (Oukbpuk)

o

Calculate (Oukbpuk)

o

Symbolic | peal
£ U XD,
» N MIEK

2.0 U AR,
WDREE

Geometry Expressions will calculate the slope of lines, segments, polygon
sides, or vectors with these steps:

------

1. Select i a line type.

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Slope tool in the Calculate toolbox or select Slope from the
Calculate menu.

The equation for the slope with real or symbolic terms appears in the

diagram.
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Calculate Coordinates

Calculate (Oukbpuk) x| | Calculake (QukpUt) X

Symbolic | Real Symbolic |} Real

LOUAAT) ||LOULAD)
» O MHER ORI

You can calculate the coordinates of any point in your diagram with these
steps:

------

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Coordinates tool in the Calculate toolbox or select
Coordinates from the Calculate menu.

The real or symbolic coordinates appear by the point.

Area Calculation

Calculate (Oukbpuk) x| | Calculake (QukpUt) X

Symbaolic | pegl Symbolic |} Real

LOULAL,| || EOUKHE,
(WoHEx | | (@R

You can obtain the area of any polygon or circle in your diagram.

Note: If your polygon is not filled it is just a group of line segments. To
convert them to a polygon, use the Polygon Construction tool, then
proceed with these steps:

------

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Area tool in the Calculate toolbox or select Area from the
Calculate menu.

The area is displayed in real or symbolic terms.
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Perimeter Calculation

Calculate (Oukbpuk)

o

Calculate (Oukbpuk)

o

Symbolic | peal

28 2 K A 3,
W

B = K R
L,

You can obtain the perimeter of any polygon or circle in your diagram.

Note: If your polygon is not filled it is just a group of line segments. To
convert them to a polygon, use the Polygon Construction tool, then

proceed with these steps:

------

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Perimeter tool in the Calculate toolbox or select Perimeter

from the Calculate menu.

The perimeter is displayed in real or symbolic terms.

Calculate Coefficients

Calculate (Oukbpuk)

1 x

Calculate (Oukbpuk)

1 x

Symbolic | peal

2% 24K A,

DU H G,

w W

Use this tool to calculate the coefficients of a vector in the diagram with

these steps:

------

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Coefficients tool in the Calculate toolbox or select
Coefficients from the Calculate menu.

The real or symbolic coefficients appear by the vector.
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Calculating Parametric Equations

Calculate (Oukbpuk) x| | Calculake (QukpUt) X
Symbolic | peal Symbolic ;ﬂﬁéai ......

2OAAYE| |[eoux s,
._t" ’tF_J;‘ % v} g% E_',EJ;} %

Computes parametric equations for a locus or envelope, based on the
parameter defining the curve.

You can also calculate parametric equations for a circle or line.

Use these steps:

------

1. Select %1 any geometry object described above.

2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Parametric Equation tool in the Calculate toolbox or
select Parametric Equation from the Calculate menu.

The real or symbolic equations for x and y appear by the geometry.

Calculating Implicit Equation

Calculake (Oukpuk) R x| | Calculake (QukpUE) o x
Symbolic | peal Symbalic iﬁééi ......

LOALAA| ||LoULHR
» ¥ G0 4 Y Y-

Calculates the implicit equation for the selected circle or a line.

Geometry Expressions will also attempt to calculate the equation of a locus
or envelope curve.

------
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2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Implicit Equation tool in the Calculate toolbox or select
Implicit Equation from the Calculate menu.

The real or symbolic equation appears by the geometry.

Output
B Output
Use Assumptions False
IUse Intermediate Variables False
Show Mame True
Show System Variables False
Maximum Size Allowed On Diagram 2

Viewing the Output

The Output settings apply to Symbolic Calculations. The general default
Output settings are found in the Edit / Preferences menu selection,

¢[]
Math tab Math

Individual outputs can be adjusted in the Display Properties dialog.
Select the output(s), then invoke the dialog in one of two ways:

e right click the mouse and select All Properties from the Selection
context menu
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\ [x:z-h-ntz-(a-z-ﬂ
=
S W=2-oti1-h
Cut
Copy
Copy As L
Send to Mathematica
Paste
Delete

Hide Ciri+H
Arrange 3

Convert to Real
Convert to Constraint (Input)

Line Properties
Output Properties
Show Symbaol
Text Properties

All Properties...

e from the menu bar, select Edit / Properties

v vy v

Display Properties

Font 10; Swiss; Arial; Mormal; Mormal; Mot Underlir #
Line Equation Style ax+by+c=0
e smbol v
Decimal Digts (0 to 8) _
E Output True
s Assumptions False

Use Intermediate Variables  False
Show Intermediate Variables | True

Show Mame False

Showe Cn Diagram True

Show In Qutput Window False L
[ K. ] [ Cancel ]

The Output selections specify how the calculations are made and how the
output is displayed.

Use Assumptions - applies to equations containing absolute values.
Use Intermediate Variables - can sometimes simplify the output.

The "Show" check boxes control where the output is displayed.
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Click the Output selection, and then the drop-down arrow '~ to select the
desired state - True or False.

Assumptions

With the Use Assumptions selection, Geometry Expressions eliminates the
absolute value from expressions and determines from the diagram
whether the value is positive or negative. Try it with these steps:

------

1. select %1 one or more output calculations

2. right click the mouse and select All Properties from the Selection
context menu

3. click anywhere on the Use Assumptions line in the Output box

4. click the drop-down arrow '~

5. select False or True

Obviously, this tool only has an effect when the expression selected
contains an absolute value.

Intermediate Variables

Substituting intermediate variables can sometimes simplify expressions
calculated by the program. Try this option to see how it affects your
output:

------

1. select %1 one or more output calculations

2. right click the mouse and select All Properties from the Selection
context menu

3. click anywhere on the Use Intermediate Variables line in the Output
box

4. click the drop-down arrow '~

5. select False or True

If Use Intermediate Variables is False, the Show Intermediate Variables is
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inactive.

Note: Intermediate variables are not always used in calculations, in which
case this box will have no effect.

Show Output Check Boxes

Display Properties

Font 10; Swiss; Arial; Mormal; Mormal; Mot Underlir #
Line Equation Style ax+by+c=0
e smbol v
Decimal Digts (0 to 8) _
B Dutput True

Use Assumptions False
Use Intermediate Variables  False

L= EUigis Yaliallics L=

Show Mame False

Showe Cn Diagram True

Show In Qutput Window False L
[ K. ] [ Cancel

After you generate an output expression:

1.
2.

3.
4,
5.

click the output

right click the mouse and select All Properties from the Selection
context menu

click one of the Output / Show. . . rows
click the drop-down arrow ~

select False or True

Show Intermediate Variables - if the system uses intermediate
variables, their definitions are displayed in the output window.

Show Name - is a term assigned by the system to the output. This name

is z, where n is the sequential number of the output .
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EH Output B Output
Use Assumptions False

se Intermediate Variables  False
Shove Intermediate Variables | True
Shove Mame Tru

"
[ Ok l [ Cancel

Use Assumptions False
Use Intermediate Variables | False
Show Intermediate Variables | Trus
Showe Mame als

(0] 4 ] [ Cancel

X2y vt gt 2 viat=) X2 %o viy 22 2t 2yl at=

You can change the output name by double clicking the output and
entering a new name in the box.

Zy=> NEﬁLength“I 0s(0)

Length1l= \Ez+b2-2-a-b-c05{8}

Show On Diagram - puts the output expression on the diagram when
True.

Show in Output Window - puts the output expression in the Output
Window when True. If this value is True, then Show Name becomes True

Too Big for Diagram - the output expression is moved to the output
window when True (Show in Output Window becomes True, Show On

Diagram becomes False).
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Symbols

Using Symbols

- |
Greek Lower | Greek Upper I

ol By 6)e)€|m|O]

The Symbols toolbox lets you easily insert Greek letters into your

expressions and constraints. Click the tab to choose from lower case or
upper case Greek letters.

The bottom row of buttons in the toolbox lets you insert commonly used
math operations.

For entering ﬂ, you can also type pi.

Inserting Greek Letters

To insert Greek letters into any variable name or expression, click the
appropriate tab, Greek Upper (upper case letters) or Greek Lower

( lower case letters) in the Symbols toolbox, and click the letters to be
inserted into the data entry box.
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-.-\ _."‘---..,.

N

entry highlighted

click the symbol
press the enter key

Multiplication & Division Editing Tools

" IThe Multiplication button inserts a multiplication symbol into the
expression.

[u]

o The Division button makes expressions easier to enter and read.

e From the data entry box, enter the numerator of the expression,
highlight it, and then click Division.

g xt

The cursor is then positioned in the denominator.

e If you click the Division button first, be sure to place the cursor in the
appropriate place before typing the expression.

Square Root Editing Tool

?@l You can enter square roots in one of two ways:
e From the data entry box, enter the expression you want inside the
square root, highlight the terms, and click the Square Root button.

e From the data entry box, click the Square Root button, then highlight
the 0 and type the terms.
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e Use the sgrt() function in the data entry box.

\,E :

sqri(2)

——

Subscript / Superscript Editor

You can enter superscripts or subscripts for variables in one of these
ways:

e From the data entry box, enter the expression you want sub/
superscripted, highlight the terms and click the Subscript Ba or
o
Superscript (2| button.

=) o)

e From the data entry box, click the Sub/Superscript button and type
the values into the grey boxes.

iy o

Note: Make sure the cursor is positioned at the left side of the gray
box before typing the sub/superscript.

e Another way to make a subscript is to use square brackets - A[1] = Aq

Parentheses and Absolute Value Notation

You can add parentheses or an absolute value sign to a term in one of two
ways:

e From the data input box, type the term(s), highlight the term(s), then
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click the Parentheses @J or Absolute Value HJ button.

I s Oty

e From the data entry box, click the Parentheses (@) or Absolute
Value 12l button first and enter the terms.

Built-In Functions

For including in any expression or constraint, Gx has the following
common functions available:

Trig
e sin() e arcsin() e sinh()
e cos() e arccos() e cosh()
e tan() e arctan() e tanh()
Math
® sqrt() - same as ﬂj e abs() - same as ﬂj
e signum(x) - finds the sign of a e exp(x) - the exponential
number: function; you must use exp,
=-1ifx<0 not e, e is just a variable name
Oifx=20
1ifx>0
e log() or In() - both mean the e piecewise({expressionl,
natural log domainl},{expression2,
domain2}...) - the function is
evaluated in the order written
e diff(expression, variable) e integrate(expression, variable)
* sum(expression, variable = e pi - same as (%] in the Symbols
start, end) toolbox
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AND
OR
NOT

V V. A A
Il

Using Annotation Symbols

Annotation Symbols

o x

METS eI EIEI B EY
Al 2)«] K=~

Annotation Symbols are available for use with any of the Annotate
tools. These symbols are not used in Geometry Expressions' algebra
engine, but may be useful in creating worksheets and tests.

Use the symbols from the data entry window of the Annotate tools.
Simply click the symbol you need as you type.

50

a=3

] “f — L] f= 4

y ;.l}}- _dlk_‘-lll _-%/ A %

Symbols o=

ek Lower

a/Bly)8]e/C)n/0]
LKA p|vE]ofm)
plojtjv]éX|v]e)
)N B @) a1 {5 =

Annotation Symbaols o

CRI<)zl==] =)z
AJ[C <)<l =]~

© 2012 Saltire Software




140 Geometry Expressions Manual

@ Font trouble - some of the Annotation Symbols may not show up in
your drawing, depending on your OS and the default font setting.
(Windows 7 users have no worries.) If you don't see an Annotation
Symbol, change the Edit / Preferences / Math / Annotation / Font /
Face Name. Try one of the Unicode fonts, e.g. Lucida Sans Unicode. If
you are exporting a Metafile, you may have to change the default font in
the program to which you are exporting.
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System Variables and Animation

Variables | Functions |

Mame Value Locked

a 1.4363364 S

b 3.9423824 -

w[i0] 1 -

x[1] 28042987 -

v[0] 0.65420561 -

vI1] 0.50859456 -

B 13097391 - |

p 130.97391 il
W nww—]

v
45 ®|4_| + [ 175
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Investigating Variables

{® Geometry Expressions

File  Edit

&

<

¢y Rugby_kick.gx

Wiews Draw Annokate  Constrain (Input)  Constrock

DEH SR +2BED O

{» Animationl.gx ¥

c

A[}{n -Ynj

|3

|1

Calculate (Output)  Help

Qe QE

Conskruck

Wariables o

Wariables | Functions

Mame Walue Locked
a 1.4363364 -
b 39423324 -
*[0] 1 -
1] 7. 5042957 -
y[0] 065420561 -
y[1] -0.50559456 -

130.97391

|
F | |13|:|.9?391 |
-..--—'i

s BlEE

Ready

Selecting | (3.25728,6.72119)

Degrezs )

The Variables toolbox reports all the variables you have used in the
diagram and lets you manipulate their values.
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Variables List

Variables | Functions

Mame Value Locked
a 1,4363364

b 3.9423824

w[i0] 1

x[1] 2,8042987

v[0] -0.65420561

v[1] -0, 50853456

g 13097391 =

& 13097391 ah

M > 0@ w—
—J
45 34 = | 175

This list contains the names of all variables used in your diagram.

For every variable name, the system shows:

e the current value - these values can be ones that you have explicitly
specified, or just taken from the way you sketched the geometry.

e lock status - if the variable is locked (+) its value will not change if
you move the geometry or add additional constraints; the unlocked (-)
variable is free to change as the geometry moves or changes.

Functions List

When using the Function command to draw a function of the form Y=f(X)
+g(X), the Functions tab in the Variables toolbox lists the functions f
and g and their values. Use the edit line at the bottom of the box to
modify the functions.
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{® Geometry Expressions

File Edit View Draw Annotate Constrain (Input)  Construck  Calculate (Output)  Help

BREUE n vREE0 O QRQAQEQ
¢ Rugby_kick.gx ¢ Animation1.gx {» functions.gx Construck qx
2 PV VRV Ay .
QYOG A

ax

‘ariables
Variables | Funckions |—
Mame Value

f Flw]4ecepfiFlk] w)~ ]l'-. .

gl [+expliglk]

edit window
1-2 L —--.....‘\
4

| FlvexplifIkl %)~ (2 -1 (((-Lal)| Iﬂ

{— | = o -

. i i
Ready Selecting | (6.02083,2.97917) Degrees |w
————

Using the Lock Tool

By default, when you drag points in a Geometry Expressions model, it will
adjust the numerical sample values used in the various parameters of the
model to accommodate the drag, as best it can.

For example, in the model of a 4 bar linkage below, dragging point B will
cause lengths a and b and angle 6 to be adjusted appropriately.
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However, you may want the drag to act as if the members AB and BC

(X4.¥4)

145

were rigid, and only angle theta adjustable. To do this you can lock the

parameters:

Variables | Functions |

Mame Value Locked

a 2.5 +

b 3.1509052  +

c 3.081761 +

[0] 24299065 +

x[1] 2.7476636  +

ylo] 10654206  +

v1] 10841121 4+

B 11230514 -

a 2I5 @

FY

Wl nonw—:
=
W

1.2755897 JJ 4 | & [5.1023587

The value of a, for example, can still be set from the Variables panel, but
it will not change when the model is dragged.

© 2012 Saltire Software




146 Geometry Expressions Manual

Changing and Locking the Variable Value

3 117.055 o\

To make a change to the variable list, first click anyplace in the row of the
variable you want to change. That row will be highlighted.

To change the value: highlight the value in the edit window and type the
new value.

To change the lock status: just click the button -
9 to unlock a locked variable

' to lock an open variable

Animation

Your geometry comes to life with the Animation tools. You simply need to
select the parameter that drives the animation, give it a range, then Play.

In the diagram below we select 0 for the crank of this linkage.
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{® Geometry Expressions

B[(=1E

File Edit View Draw Annotate Constrain (Input)  Construck  Calculate (Output)  Help
RO oS s - Q& [EEQ
BB s +REEHE D Q[
¢ Rugby_kick.gx q':: Animatiﬂnl.gxé | ¢ functions.gx Construct X
-~ .__/ /l ._./ ..‘.f | i /) .__/ .__/ F
C L LA K4z
o P Y AN
N4 - 0
‘ariables o x
Variables |Functiu:uns
b Mame Value Locked
b a 1.3383496
b 39329106
*[0] 1
1] 38697193
0] -0.65420561
w[1] 0
H | |
B
0 F | |1.8542993 |
4 [}{ j,rj -
14
P —
A v
[}{nd’nj ¥ i § & [ g.283185
:
p . E e
Ready Selecting | (1.45833,-7.66667) Radians |

Click the headings below for details on the animation buttons and

windows:

stepped through.

range for the driving parameter.

Users of numeric interactive geometry systems m
concept of animation based on points animated al

Animation console - works like a video player.

Animation modes - indicates how the range for the animation is

Animation values and duration - where you specify the speed and the

ay be familiar with the
ong line segments or

curves. This type of animation can be conveniently modeled in Geometry

Expressions using the point proportional along a
with parameter based animation.

curve constraint along
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Animation Console

“| [‘| “' | “' The Animation console works like a standard video
console with the Play, Pause, and Stop buttons as well as advance to
the Beginning and End buttons.

Animation Modes

¥ The animation modes can be changed with the up/down arrow
buttons. The modes are:

“=# Runs the animation one time through the specified range.

==3 Runs the animation continuously from the beginning to the end
of the range.

#22 Runs the animation one time forward and then backward
through the specified range.

€22 Runs the animation continuously forward and then backward
through the specified range.

Animation Values and Duration

444089 | (@)1 |2 [177636

These animation buttons help you adjust the range and speed of the
animation.
e Click and drag the slider along the bar to manually animate the
drawing.

e In the two data entry windows at the bottom right and left of the
toolbox, specify the range of the animation.

e The Duration box in the center lets you specify how long the
animation takes to play one time through. Values are between 1 and
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60 seconds.

Animation and the Locus Tool

Both the construction of the locus and envelope curves, and the animation
of the diagram in Geometry Expressions can be defined in terms of any
variable. For example in the model below, we can create a locus over
values of the variable t (other variables will be kept constant).

{® Geometry Expressions
File Edit View Draw Annotate Constrain (Input)  Constrock

HREOH s B ER O QQEHQ
Conskruck o x
S A AW AT TN /2
“’{:3 r/] 'Y ey : IKCJ/ i
YWariables o x

Yariables | Functions

Calculate (Output)  Help

¢ Rugby _kick.gx ¢ Animation 1.gx {» Oval of Cassinigx

Oval of Cassini

Mame Value Locked

a 2.75
k 3. 23053563

4,5746119

r | |4.E?4E-119 |
..... — 8

Eal G iCa

|

b

Ready Selecting | {1.45833,-7.66667) Radians
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Many of the menus and icons across the top of the screen duplicate the
commands and functions found in the toolboxes.

File Menu

The File menu contains the standard Windows file handling operations
with options for copying and exporting to other programs. Several of the
options are also available from the icon bar.

Menu Option Function
|:| Creates a new project.
New
New Graph Graph mode allows scaling of axes.
EJ Brings up the Select a File dialog box so you
Open. can open a project.
Close Closes the current file or, if multiple files are
open, the file on top.
H Saves the file. If you have not yet saved the
Save current work to a file, the Save File As
dialog box lets you specify where to save the
project file.
Save As . .. Brings up the Save File As dialog box to

enter a new or different path / file name.
Useful for making a backup.

Open Workbook Brings up the Open Workbook dialog box.
If any other files are open, they will be closed
when you select the workbook.

Save Workbook Saves all tabbed pages as a single workspace
(.gxw), so you can open them all at once.

Save Workbook as Saves all tabbed pages as a single workbook
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Close Workbook

Import Figure from
Figure Gallery

Import GX File from
Geometry Atlas

Export

Page Setup. . .

= Print Preview

5 Print. . .

Recent files

Exit

153

(.gxw) and lets you specify a new or different
path / file name for the workbook.

Closes the current workbook. If you have
made changes to pages, you will be asked if

you want to save them individually (.gx files).

A shortcut containing common geometry
figures that you may need for creating
worksheets or other documents.

Import one of the many interesting theorems
and problems already constructed. Browse
through the files and select one to explore.

Export the file as Windows Metafile (.emf) (
Windows version only), image file, an
Encapsulated PostScript (.eps), HTML file (.
html), animated gif, JavaScript file, Lua app,
or OS X Dashboard Widget.

Displays the page setup dialog box for
choosing a printer and print options.

Displays the printout by pages.
Displays the standard system Print dialog.
Click to display a list of the most recently

used files. Selecting one opens it.

Exits the program, after prompting for save.

Importing Files from the Figure Gallery

Are there figures which you need to use frequently? The Figure Gallery
makes your tasks easier. Browse through the folders to see the many
objects, graphs and transformation examples which you can use and tailor
to your needs without starting from scratch.

Figure Gallery database file is copied to your computer when you install
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Geometry Expressions.

Here are the steps to import a figure:
1. Select File / Import Figure from Figure Gallery
2. Double click a folder or sub-folder (or click and press Select in the

lower right corner) to view of the problems in a category. You can
also use the search window to find files.

Import a Figure g|
-I.‘C;J |Search | l G0 l Home > Solids
Cone
A
L=
Hemisphere Pyramid
<‘-.______ ______,ﬂ-:) A-_:_'___d__:_ ::__—:_;1

3. Double click a problem (or click and press Select) to see an enlarged

view

4. Click the Import button (it replaces the Select button in the lower right
corner) to bring the drawing into your drawing window.

Use the Toggle Hidden function from the general context menu to modify
constraints in the drawing, or try dragging the geometry to suit your
needs. Don't forget to Save.
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Navigating the Figure Gallery

The Figure Gallery is arranged in the usual tree structure containing

folders and sub-folders.

Import a Figure g|
-I.‘C;J |Search | l G0 Home > Solids
Cone
N
=
Hemisphere Pyramid
AN |
< D L i

)
L Back - takes you up one level.

@ Home - takes you to the top level.

Use the Search window to find a specific file or types of files. Enter the

search word(s) and click Go.

Text at the top center of the dialog tells you which level is displayed. Click

Home to return to the top level.

Importing Files from the Geometry Atlas

The Geometry Atlas is a huge collection of interesting theorems and
problems which are already constructed, waiting for you to discover their

mysteries. You just need to have internet access.
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Browse through the atlas, organized in the usual tree structure by
geometry element. Here are the steps:

1. Make sure your computer is on-line.
2. Select File / Import GX File from Geometry Atlas.

3. Double click a folder or sub-folder (or select the folder and press the
Select button) to view the problems or sub-folder.

Import GX File X
| [ G0 ] Home = Triangles = Scalene Tr... = Inscribed ...
2 Known Angles and a 2 Known Angles and
Non-Included Side the Included Side
': / : \"\\ 'J,f : \\ |
2 Known Sides and a 2 Known Sides and the
Non-Included Angle Included Angle s
W)\ ANTAN
[IIIlllllllllllllllllllllq

4. Double click a problem (or select the problem and press Select) to see
an enlarged view.

5. Click the Import button to bring the drawing into your drawing
window.

Browsing the Atlas

g takes you up one level.
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takes you to the top level.

Use the Search window to find a specific file or types of files. Enter the
search word(s) and click Go.

Text at the top center of the dialog tells you which level is displayed. Click
Home to return to the top level.

Exporting a Drawing

& Goometry Expressions
m Edit View Draw Annotate Constrain (Input] Construct Calculate (Cutput] He
Mew

Ctrl+ M i 1
Mew Graph Ct:I:G :I E E lﬁ i::ﬁ \% II

Open... Crl+C
Cloze Ctrl+W

Save Ctrl+5
Save As..,

Open Workbook...
Save Workbook
Save Workbook 4.
Close Workbook

Import Figure from Figure Gallery
Import GX File from Geometry Atlas

Page Setup... Encapsulated PostScript (.eps)
Print Preview Windows Enhanced Metafile (.emf)
Print... Ctrl+P HTML {.htmnl)
Recent Files L Animation
Exit HTMLS / JavaScript App
i
K Lua &pp
/ 05 X Dashboard Widget
[ | ~

To export your drawing to another program, choose File / Export. You
can export the drawing in the following formats:
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Static File Formats Dynamic File
Formats
TIFF, PNG, XMP
e Encapsulated e HTML5 /
Postscript JavaScript App
e Windows Enhanced e Lua App
Metafile
e HTML e OS X
Dashboard
Widget

@ Please note that neither EMF, nor EPS support semi-transparency or
transparent images of any kind, thus you will get a warning message if
you try to export to either of these formats and you have such an item in
the document.

Here are the steps for the export as an Image file, EPS, EMF or HTML.:

1. For all file types enter the Filename or click the folder icon to select the
appropriate folder and file.

2. Image files and HTML files have an extra step at this point as detailed
below.

3. Select the region of the drawing with the displayed cursor :
(click-and-drag opposite corners of the region).

Animation Files and JavaScript Files have a few more details to consider as
explained below.
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Exporting Image Files

When exporting image files, click the down arrow in the Save as type
line to select your desired image format.

‘:'l File name: Conice1 w
-
My Netwokk  Saveastps: | Btmap (*bmp) v

Next, set the resolution in the File DPI box. Click the down arrow and
select the appropriate setting or enter a humber in the window.

Image Export §|

File Path: C:\Documents and Setki, . bedeletediMapoleon, brp
File Type: BMP file (*.brap)

FleDPl: | B +

[ oK ] [ Cancel

Exporting HTML Files

When you select File / Export / HTML, the HTML Export dialog
appears.

Fill in the Html Export Settings with optional Title, Header and Footer text.
The Qutputs can be renamed to something less obscure than letters with
subscripts. You can give them actual labels using real words. You can
also display your output expressions in many popular CAS input formats
including Content and Presentation MathML.
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Html Export

EH Html Export Settings
Qutput Directory
File Mame
Webpage Title
YWebpage Header Text

C:\Geometry_Conics
parabolas.himl

Parabola Tangents
Prove distance z[1].

Mr. Todd's Period 4 Class

d|(x]

B {Qutputs:
o[1] True; Q[1]
B Expression Qutput Forms
Display Derive input True
Display Maple input True L
[ QK l [ Cancel
E Html EBxport Settings ”
Qutput Directory C:\Geometry_Conics
File Mame parabalas.himl
Webpage Title Parabola Tangents
YWebpage Header Text Prove distance z[1].
Webpage Footer Text Mr. Todd's Period 4 Class
E Outputs;
B of1] True; Q[1]
Showe in Export True
Label Q1]
E Expression Output Forms b

Exporting Animation Files

Select File / Export / Animation File to produce an animated gif. This
format is supported by many applications and will enable you to embed
animations in, for example, PowerPoint slides and Wikipedia pages.

Select the directory and file name of your gif, and you will be presented
with a dialog to choose the parameter on which the animation is based,

along with various technical aspects of the animation.
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Animation Export

File Path: C:\GeametryExprassionsirefleckion, gif
File Type: Animated GIF
File DPT: Use screen DPL w

Frames Per Second: | 10 %
Murnber of iterations: 0| % Enter "0" for unlimited iterations.

Yariable: Eow

[ oK ][ Cancel ]

File DPI - specify the resolution of the output. The higher humber you
use, the slower will be the process of creating and loading the animation.

Frames Per Second - if you multiply this number by the animation
duration specified in the Variables toolbox, you will get the number of
frames captured. For example if you are set at 10 frames per second,
and the Variables toolbox specifies the duration of the animation to be 4
seconds, then 40 frames will be captured. The more frames you capture,
the slower will be the animation creation process, and the longer the
animation will take to load.

Number of iterations - when an animation is played (e.g. when a
PowerPoint slide containing the animation is displayed), enter a number
to play the animation a specific number of times, or enter 0 to play it
continuously.

Variable - choose the variable that controls the animation. (All the
variables in the Variables toolbox should be available). The limits of the
variable defining the range of the animation should be set in the
Variables toolbox.

Exporting JavaScript Files
Select File / Export / [HTML5 / JavaScript App] - to export a
Geometry Expressions model as a JavaScript application (.html file), within

an html page. This can then run within a web browser (so long as the
browser supports HTML 5).

Fill out the details in the JavaScript Applet Generator dialog.
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Javascript Applet Generator

B Applet settings

Qutput Directory C:\GeometryExpressions\GE_Files),
Applet Mame unnamed1
Auto-scale True
Width 350
Height 350
Webpage Title Incircle Radius
Webpage Header Text | What lengths make the radius an integer?
Webpage Footer Text | What if the triangle were <b=Pythagorean</b=?
C55 file (optional)
B Inputs
H a
Show in Export True
IEEE RN sice ec]
UL Type Text Box
B b
Show in Export True
Label side AC
UL Type Text Box
H c
Show in Export True
Label side AB
UL Type Text Box
B Outputs
B z[0]
Show in Export True
Label radius

QK | Cancel

Output directory - tells Gx where to put the files. It will create a file:
name.html! in the specified directory. You should be able to bring
name.html up in a browser to see the applet.

Applet Name - is the name of the html file.

Auto-scale - when set to True, the JavaScript applet automatically rescales
the drawing when the user changes the value of one of the inputs; when
set to False, you click-and-drag a rectangle around the drawing after you

click Ok.

Width and Height specify the size of the drawing on the html page.
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Webpage Title, Webpage Header Text, and Webpage Footer Text - enter
your text for these sections of the applet.

Since header and footer text may be several lines long, You can go back
and change these text boxes before you close the dialog:

e select the text entry box
o click the = to display the dialog
e enter or edit text, then click Ok.

Note: you can insert html code into the header and footer text, e.g. to
make a word in the footer text bold:

Webpage Footer Text
What if the triangle is <b > Pythagorean </b=? ;1
-
Ok | Cancel |
P

Inputs - lets you choose which variables the user will be able to change,
what text Label identifies variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the
JavaScript model. You can choose whether to use an edit field or a slider

to control the variable. @ Please note not all browsers support sliders.

Any points in the Geometry Expressions model constrained by variable
Coordinates or a variable parameter for the Point Proportional
constraint can be set as draggable points in the JavaScript model. These
variables, however, cannot be functions or negative; only positive
variables are allowed for defining draggable points. I.e., the value of the
variable may very well be negative, but using -t as the point proportional
parameter or (X, 3*x) as a point's coordinates will not work.
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B Inputs

Bt
Show in Export
Label

True
t

UI Type Text Box

B f
Show in Export
Label
UL Type

Text Box

)
Text Box

Input functions can be modified in the Text Box field with single or
multi-line JavaScript notation. Remember to use return in multi-line

JavaScript statements.

E Inputs

Bt
Shaowe in Expart
Label
UL Type

B f
Showe in Expart
Label

True
t
TextBox

True

fx)

LI Type Text Box

-

Text Box
Multiline Text Box

@ Note: when defining variables or functions in the edit field, remember

that JavaScript does not use "M" to denote a power. X% must be written:

pow(X,2) .

Outputs - lets you choose which outputs will appear in the applet, and

their text Label.

Any measurements which are present in the Geometry Expressions model
may be chosen as outputs for the JavaScript model. Select True from the

Show in Export line.

See the examplebelow.
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JavaScript Applet Example

We'll use this Gx model, displaying the radius of an incircle to create a

JavaScript Applet.

=

165

Ja+b-c-\fa-b+c--a+b+c

2-.Ja+b+c

Here are the parameters we entered in the JavaScript Applet Generator

dialog:

Here is the result:

B Applet Settimgs
Curtpurt Dwechony
At e
FarS el
Hesght
‘Webpage Tite

C'eomeryExpressions o _Files|
urrared 1

Tk

350

350

Ercingie Fadus

‘Wiebpage Header Text | What lengths make the rsdus aninteger?

Webgags Foattr Text  What if the Fiangls werg SePySugareanobs? |
|

55 fie (pptoral)
B Inputs
=
Shon in Expart

LT Type

=)
Shew in Expart
Lishel
LIl Tepe

=]f
Shoew in Expoet
Lasbed
Ul Type

B Oulputs

B o]
Sheww i Expori
Lashed

Truae
ke B
Text B

Tirue
e A
Teat Bon

Tiruse:
e AR
Teat Boos

Tiwe
radius

L= | ome |
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Incircle Radius

What lengths make the radius an integer?

B

()

A
side BC |6

side AC |8

side AB |10]

radius 2

What if the triangle is Pythagorean?

applet generated by Geometry Expressions j

The exported image can be zoom in and out using - and + keys on the
keyboard or pan it around using the arrow keys.
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JavaScript Animated Applet

In this applet, we'll draw a general function, f(x) and then create its

E
derivative at t (using the Point proportional ;g—'i constraint). Here is the
Gx drawing:

Yariakiles x|
Viriabies | Functions |

Hame | Vahe | Loscked |
t 5.02

r e

LTRSS
— =flt)+(x-t)

o E}f“_jlf—_ Y=f{t)+H{X-1)-f(t)

A

Here are the parameters we entered in the JavaScript Applet Generator
dialog:
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Javascript Applet Generator x|
B Applet Settings
Qutput Directory C:\GeometryExpressions\GE_Fies),
Applet Naime derrvative
Auto-scale Trus
Width 350
Height 320
Webpage Title The Derivative of a Function at Point t
\Webpage Header Text
Webpage Footer Text | Mow modify the function.
C55 file (optional)
B Inputs
Bl t
Shiow i Export True
Label k
UI Type Slider
Bl f
Show in Export True
Label f{x)
LI Type Multiline Text Box |
oK I Cancel |
P

Selecting slider for the UI Type of variable t we now have the Go/Stop
button to control the animation of t between the ranges defined in the

Variables panel above.
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The Derivative of a Function at Point t

t [5022857
-2.00000 30227 300000
fix) [[(0.3850334 3068696 )+ 1 0¢

Now modify the function.

App preamied by Oeomatry Bxprssion

Tes]]

e [

-2.00000 20000

var am3:
war be2:
rerturn a+brsin (x)

169

© 2012 Saltire Software




170 Geometry Expressions Manual

To modify the function, simply type a new one in the edit field. A multi-
line function allows more options.

Creating Lua Applets

If you have a TI-Nspire™ calculator, you can put your Geometry
Expressions model on it by creating an interactive Lua app.

Variables can be adjusted from a text box or with a slider. Any points in
the Geometry Expressions model constrained by variable Coordinates or
a variable parameter for the Point Proportional constraint can be set as
draggable points in the Lua app.

After you create your Gx model select File / Export /Lua App. Fill out
the details in the Lua App Generator dialog.

Lua App Generator x|

Bl Applet Settings
COutput Directary | T:For Hannah'

Applet Mame unnamed3
Auto-scale True
Bl Inputs
B a
Show in Expori True
Label a
UL Type Text Box
Bt
Show in Expori True
Label t
Text Box -
Bl Outputs Draggable
El crankangle Slider
Show in Expori| Text Box
Label crankangle
Ok Cancel
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Output directory - tells Gx where to put the file. It will create a file:
name.tns in the specified directory.

Applet Name - is the name of the Lua (.tns) file.

Auto-scale - when set to True, the Lua applet automatically rescales the
drawing when the user changes the value of one of the inputs; when set
to False, you are prompted to click-and-drag a rectangle around the
drawing after you click Ok.

Inputs - lets you choose which variables the user will be able to change,
what text is displayed for the variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in
the Lua app. You can choose whether to use an edit field or a slider to
control the variable.

Any points in the Geometry Expressions model constrained by variable
Coordinates or a variable parameter for the Point Proportional
constraint can be set as draggable points in the Lua app. These
variables, however, cannot be functions or negative; only positive
variables are allowed for defining draggable points. I.e., the value of
the variable may very well be negative, but using -t as the point
proportional parameter or (x, 3*x) as a point's coordinates will not
work.

Outputs - lets you choose which outputs will appear in the applet, and
their text Label.

Any measurements which are present in the Geometry Expressions
model may be chosen as outputs for the Lua app. Select True from the
Show in Export line.

When you click OK, the Lua code is placed on the clipboard (and also in
the file you specified), ready to paste into your TI-Nspire Teacher
Software Script Editor.
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Tl Lua Script Editor

To make a Lua app for your TI-Nspire™, you
must have the TI-Nspire™ Teacher Software or
TI-Nspire™ CAS Teacher Software installed.

Click Insert / Script Editor / Insert Script to display the Script Editor

window.

% luaex - TI-Nspire™ CAS Teacher Softw

File Edit View Insert Tools Window

Content Documents

2
& = =
i) = = = @
Suapend oous F Enaple Ingen =
Seript Seripl Breakpoints Image Parmissions

Crank

253 mach.pov = salefow

254

285 function lerpix0, xi, y0, yl, x]

256 if x1 == x then

25T return vl

258 @lae

259 raturn ¥0 4 (x - ®0) v (¥l - yO) /S (%1 - %DV

260 end

261 end

262

263 function gethrrowlim()

264 local din = §

265 return Point(dim®*0.8, dim*3.2)

266 and

267

Q
| console Globals Calstack Locals

The app appears in the previous window.

Click Set Script.
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r Software [Trial Version]
Insert Tools Window Help

= luaex - T-Nspire™ tﬁ.s. Tes

Fila Edit View

Content Documents

P —
& insert - fr) B -

=
! i-

Documents Toolbox A . A
- .

X nffflle = =L

. = |Handheld + SideScreen ~

" lugex X 4r D

11 | Setings Document View: [E1] | Zoom: [150% ~| - +

The exported image can be zoom in and out using - and + keys on the
keyboard or pan it around using the arrow keys.

Creating OS X Dashboard Widgets

Dashboard Widgets are very similar to JavaScript Applets, but they sit on
The Mac Dashboard. Select File / Export /OS X Dashboard Widgets.

Fill out the details in the OS X Dashboard Widget Generator dialog.
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05 ¥ Dashboard Widget Generator x|
B widget Settings =
QOutput Directary
Widget Name urnamed3
Auto-scale True
Width 350
Height 350
Widget Title
Widget Header Text
Widget Footer Text
C55 file (optional)
B Inputs
H a
Show in Export | True
Label a
UL Type Text Box
Bt
Show in Export | True
Label t
Text Box x
B Outputs Craggable
B crankangle Slider

Show in Expaort

oK | Cancel

Output directory - tells Gx where to put the files. It will create a folder:
name.wdgt containing all the components of the widget.

Widget Name - is the name of the folder and the main .html file.

Auto-scale - when set to True, the Widget automatically rescales the
drawing when the user changes the value of one of the inputs; when set
to False, you click-and-drag a rectangle around the drawing after you
click Ok.

Width and Height specify the size of the drawing in the Widget box.

Widget Title, Widget Header Text, and Widget Footer Text - enter your
text for these sections.
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Since header and footer text may be several lines long, You can go back
and change these text boxes before you close the dialog:

e select the text entry box

o click the = to display the dialog
e enter or edit text, then click Ok.

Note: you can insert html code into the header and footer text, e.g. to
make a word in the footer text bold:

Widget Header Text x|

The crank is driven by the parameter <b=t=/b>; point J
<h= B </b>is proportional about the unit dircle. | J

Ok | Cancel |

CSS file (optional) - you can attach your favorite Cascading Style Sheet,
without having to reproduce it every time.

Inputs - lets you choose which variables the user will be able to change,
what text Label identifies the variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the
Widget. You can choose whether to use an edit field or a slider to control
the variable.

Any points in the Geometry Expressions model constrained by variable
Coordinates or a variable parameter for the Point Proportional
constraint can be set as Draggable in the widget. These variables,
however, cannot be expressions or negative; only positive variables are
allowed for defining draggable points. I.e., the value of the variable may
very well be negative, but using -t as the point proportional parameter or
(x, 3*x) as a point's coordinates will not work.

Input functions can be modified in the Text Box field with single or
multi-line JavaScript notation. Remember to use return in multi-line
JavaScript statements.
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E Inputs
=t
Shaowe in Expart True
Label t
UI Type TextBox
= f
Showe in Expart True
Label ()

Text Box

@ Note: when defining variables or functions in the edit field, remember
that JavaScript does not use "M" to denote a power. X? must be written:
pow(X,2) .

Outputs - lets you choose which outputs will appear in the applet, and
their text Label.

Any measurements which are present in the Geometry Expressions model
may be chosen as outputs for the widget. Select True from the Show in

Export line.

Graphing Mode

When you need to draw a graph requiring independent scaling of the axes,
select File / New Graph.

e Draw your graph.

e Click an axis - the axis will be highlighted and a circular handle
appears.

Y=exp(-X)-s

3 2mi3
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e Slide the handle up and down the axis with your mouse.
ta

Y=exp(-X)-si

IY=exp{-XI]-s
w3 2m/3

Note: Many of the geometry drawing, constraint and construction tools
are unavailable (grayed out) in the Graphing mode for obvious reasons
related to the independent scaling of the axes.

Edit Menu

The Edit menu contains the standard Windows editing operations as well
as ways of dealing with constraint conflicts and all of the program settings.
Several of the options are also available from the icon bar.

Menu Option Function When Available
V2 Reverses actions starting | After any action has
Undo with the last one. been taken.
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ey Redo

------

D“ Select

Select All

Clear Selection
@ cut

@ Copy

Copy As

3 copy
Drawing

1111111

Reinstates actions
starting with the last one
that was undone.

When checked, the select
mode is active.

Selects everything in the
drawing window.

Unselects any objects
that are selected.

Deletes an object, but
saves it so it can be
pasted somewhere else.

Does not delete the
object, but saves is so it
can be pasted
somewhere else.

Displays a submenu of
choices for copying
mathematics into other
programs.

Copies everything in the
drawing window as an
Enhanced Metafile (.emf)

Copies a section of the
drawing window inside a
rectangle made by
dragging the cursor.

Puts whatever has been
cut or copied into the
current drawing

After using Undo

Select mode is always
active except when
using a Drawing tool or
moving or panning the
drawing.

Always

Always

An object is selected

An object is selected

An expression or
formula is selected

Always

Always

Object(s) cut or copied
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Delete

Arrange

Send to
Mathematica

Convert to
Constraint

Convert to
Measurement

Convert to Real

Convert to
Symbolic
Details. . .

Parameters. . .

Properties. . .

Deletes whatever is
selected, without saving
it.

For placing selected
objects on top of (bring
forward) or underneath
(send backward) other
objects for easier
selection and viewing.

Inputs the math to
Mathematica when the
algebra system is running
in another window.

Tries to convert a
selected output [=260] to
an input constraint if
there is no conflict with
other constraints

Converts the selected
constraint into a
measurement (output)

Converts a symbolic
calculation to a real one

Converts a real
calculation to a symbolic
one

Displays the Edit Text
dialog to edit a block of
text

Lets you edit the
parameters of functions,
loci and traces.

Lets you edit the display
properties of the selected
object(s)

One or more objects
selected

One or more objects
selected

Windows version
only

An output expression
or formula is selected

An output expression is
selected

An input constraint is
selected

A symbolic output is
selected

A real output is
selected

A block of text is
selected

A function, locus or
trace is selected

One or more objects of
the same type are
selected
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Preferences . . . Sets the default Always
appearance and
properties for the
project's drawing, text
and mathematics

NOTE: For the Mac version, Preferences are found under the Geometry
Expressions menu.

Copying Mathematics

To copy expressions or functions into an Algebra system or another
program:

e Select the math from the Diagram or the Output window.
e Select Edit / Copy As or right-click the selected expression to

display the submenu of choices for copying expressions or functions
from Geometry Expressions to another program.
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& Geometry Expressions
Filemh‘im Draw Annotate Constrain (Input) Construct  Caleul

: E Undo Edit Symbaolic Value Ctrl+Z

EElE el

v Select
Select All Ctrl+A
Clear Selection
Cut Ctrl+X
Copy Ctrl+C
Copy Drawing Presentation MathML
Copy Region Tex k
Paste Ctrl+V .
Derive Input
Delete Del
Maple Input
Arrange » Mathematica Input
Maxima Input
Send to Mathematica B
MuPAD Input
TI-Mspire Input
String
Source Code k
Properties... v=|a+x5a X<-1
Preferences... 2.3 A=X and X<

e The 2 general types of MathML are available, Content and
Presentation MathML, as well as formats meeting the specific quirks
of several popular Computer Algebra programs.

e The TeX typesetting output gives you 3 choices in the submenu:Inline
, Display, and Wikipedia. The actual TeX produced is identical, except
for the delimiters which mark the start and finish of the TeX code.

e There is also a general purpose String output which converts the
selected math into a text string containing no special characters:

= -Jaz+h2-2-a-h-|:us[El]

2)))"(1/2).

is copied as > (((@)”(2)+(b)"(2)+(cos(8)*b*a*(-
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e Generate Source Code from Geometry Expressions in a number of
different languages:

C++
3-r-sin(T) c#
Y=T+ Visual Basic (.Net)
VBA
Java
JavaScript
. ActionScript

When you make a submenu selection, the selected math is copied to the
Windows clipboard, ready to be pasted into the appropriate application
(Ctrl+V).

Generating Source Code

You can generate computer source code from Geometry Expressions in a
number of different languages.

C / Objective C
C++
3-r-sin(T
g 3rsin(m) |

k-
4 Visual Basic (.Met)
VBA
lava
JavaScript
S

ActionScript

[

There are two types of expression in Geometry Expressions:
e Scalar
e Vector

The source code will be in a different form depending on whether there
are intermediate variables present or not.

Note that there is not much difference between the languages in the
mathematical expressions they generate. The main differences are:

e C#, Java, Javascript, ActionScript, Visual Basic (.net), and Lua
prefixes math functions with “Math.”

e C/ C++ and VBA do not use any prefix for the math functions
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Each language has its own way of invoking functions. In the cases where
a vector is returned from the function, the different languages work in
different ways.

e In C pointers to doubles representing the x and y coordinates of the
vector are passed into the function.

e In C++, Visual Basic and VBA, references to doubles representing the
x and y coordinates of the vector are passed into the function.

e In C# double out parameters for the x and y coordinates of the
vector are used.

e In Java, JavaScript and ActionScript, an array is passed into the
function, the 0% and 1st elements of the array will acquire the x and y
coordinates of the vector.

Source Code Examples

From the following example we'll copy the expressions for the location of
point D (a vector) and distance AD (a scalar) in our code generation.

JB+c(a-b)
Brore

distance =

’-a-b+c \,E"'tl":'-.ﬁ'h"":'\‘ll:a*'b"'ﬂ 1
2 2--.'%:1"!:]'::

location=

Scalar / No Intermediate Variables
e Select the distance expression.
e Right-click and select Copy As / Source Code / C/Objective C
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In this case the code generates a single expression (here we are
generating C):

(pow((pow(c,2)+((a+(b*-1))*c)),0.5)*pow((a+b+c),-0.5)*pow(a,0.5)).

Scalar / Intermediate Variables

With intermediate variables showing we get the following for the distance
expression:

double distance(
double a,
double b,
double c)

double d_1;

double v_1;

double phi_0;

double d_2;

double d_0;

double u_1;

d_1-=
(pow(((a*-1)+b+c),0.5)*pow((a+(b*-1)+c),0.5)*pow((a+b+(c*-1)),0.5)
*pow((a+b+c),0.5));

v_1 = (d_1*pow(a,-1)*0.5);

phi_0 = ((a+b+c)*v_1*pow(c,-1)*pow(b,-1));

d_2 = (v_1*pow(b,-1)*a*-1);

d_0 = (pow(a,2)+(pow(b,2)*-1)+pow(c,2));

u_1 = (d_O*pow(a,-1)*0.5);

return
(pow(fabs(phi_0),-1)*fabs(d_2)*pow((pow(c,2)+(u_1*c*2)+pow(u_1,2)+
pow(v_1,2)),0.5)*pow(c,-1));

¥

We see that the name of the function is the name of the expression in
Geometry Expressions, its parameters are the input variables, and its
return value is the value of the expression.

Vector / Intermediate Variables
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Select the /ocation expression, a vector value, and our function returns
two quantities. This is done in different ways for different languages:

C / Objective C
Pointers to doubles are passed into the function:
void location(

double a ,

double b,

double c,

double *location_x_,

double *location_y_ )

double location_x;
double location_y;
double d_1;
double v_1;
double d_2;
double d_0;
double u_1;
double phi_0;

d 1=

(pow(((a*-1)+b+c),0.5)*pow((a+(b*-1)+c),0.5)*pow((a+b+(c*-1)),0.5
)Y*pow((a+b+c),0.5));

v_1 = (d_1*pow(a,-1)*0.5);

d_2 = (v_1*pow(b,-1)*a*-1);

d_0 = (pow(a,2)+(pow(b,2)*-1)+pow(c,2));

u_1 = (d_O*pow(a,-1)*0.5);

phi_0 = ((a+b+c)*v_1*pow(c,-1)*pow(b,-1));

location_x = (((d_2*-1)+(u_1*d_2*pow(c,-1)*-1))*pow(phi_0,-1));
location_y = (pow(phi_0,-1)*v_1*d_2*pow(c,-1)*-1);

*location_x_ = location_x;
*location_y_ = location_y;
¥
C++

References are passed into the function:
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void location(
double a ,
double b,
double c,
double &location_x_,
double &location_y_ )

{
double location_x;
double location_y;
location_x_ = location_x;
location_y_ = location_y;

¥

C Sharp

Out parameters are passed into the function:

void location(
double a,
double b,
double c,
out double location_x_,
out double location_y_ )

{
double location_x;
double location_y;
location_x_ = location_x;
location_y_ = location_y;
b

Visual Basic / VBA
References are passed into the function:

Sub z_0(ByVal a As Double , ByVal b As Double , ByVal c As Double ,

ByRef z_0_x_ As Double ,ByRefz_0_y_ As Double )

Dim z_0_x As Double
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Dim z_0_y As Double

z 0x =z 0Xx
z 0y =z0_y
End Sub

Java
An array of doubles of size 2 is passed in and populated by the function:
double location(
double a,
double b,
double c,
double[] location_v )
{
double location(
double a,
double b,
double c,
double[] location_v )

double location_x = 0;
double location_y = 0;

location_v[0] = location_x;
location_v[1] = location_y;

¥

JavaScript
An array is passed in and populated by the function:
function location(

location_v )
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var location_x = 0;
var location_y = 0;

location_v[0] = location_x;
location_v[1] = location_y;

b
Action Script

An array is passed in and populated by the function:

public function location(

a:Number,
b:Number ,
c:Number ,
location_v:Array) )
:void
{
var location_x:Number;
var location_y:Number;
location_v[0] = location_x;
location_v[1] = location_y;
b
View Menu

The table below lists the complete summary of View functions.

Menu Option Function

Hide Hides a selection

Show all Displays any entities that
were hidden

When Available

One or more elements
are selected.

One or more elements
are hidden.
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Toggle
Hidden

Zoom In

Zoom Out

Zoom To
Selection

Zoom To Fit

Zoom To Page

@ Pan View

@)
* Scale
Geometry Up

* Scale

Lets you toggle hidden /
visible for any object in

the drawing

Makes the drawing details
larger without affecting

the size on the printed

page. (The text gets larger

on the screen.)

Makes the drawing details
smaller without affecting

the size on the printed
page. (The text gets

smaller on the screen.)

Lets you make a selection

and adjusts it to fit the

drawing window. (The text
gets larger on the screen.)

The entire diagram is

displayed in the drawing

window. (The text size
changes with the
geometry.)

The whole page is

displayed in the drawing

window. (The text size
changes with the
geometry.)

Allows you to move the
contents of the drawing
window without changing
its position on the page.

Enlarges only the

geometry. (The text size

on the screen doesn't
change.)

Shrinks only the

geometry. (The text size

189

Always (if the drawing
window isn't empty)

Always available -
(most useful when
there is something in
the drawing window).

Always available -
(most useful when
there is something in
the drawing window).

Always available -
(most useful when
there is something in
the drawing window).

Always available -
(most useful when
there is something in
the drawing window).

Always available -
(most useful when
there is something in
the drawing window).

Always available -
either Pan View or
Move Geometry will

be in effect (checked).

Always

Always
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Geometry Down

uuuuuu

Geometry To
Selection

Scale
Geometry To Fit

ﬂ Scale
Geometry To
Page

a Move

Geometry

Axes

Grid

Page Boundaries

Tool Panels

Tool Panel
Configurations

on the screen doesn't
change.)

Lets you select a portion
of the geometry and
adjusts it to fit the drawing
window (The text size on
the screen doesn't
change.)

Adjusts all geometry to fit
in the drawing window.
(The text size on the
screen doesn't change.)

Adjusts all geometry to fit
inside the specified page
boundaries. (The text size
doesn't change relative to
the page.)

When checked, click and
drag to move the drawing
contents with respect to
the page boundaries.

When checked, the axes
are displayed. They have
the properties of Infinite
Lines.

When checked, the grid is
displayed.

When checked, the page
boundaries are displayed.

Lists all the toolboxes.
When checked, the
toolboxes are displayed on
the screen.

Gives you options for
arranging the toolboxes to
your preference.

Always

Always

Always

Always. Make sure
Page Boundaries is
checked (below) to
see the results.

Always

Always

Always

Always
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Output When checked, the output | Always
window is displayed.

Language The current version of Always
Geometry Expressions can
be displayed in English,
French, German,
Spanish, Polish, or
Russian. Choose one and
restart the program.

Checked menu options are toggles:
e Checked indicates the option / mode is active or displayed.

e Unchecked indicates the option / mode is inactive or hidden.

e Except Pan View and Move Geometry where one or the other is
checked.

Click the selection to change its state.

Some menu items have icon shortcuts found on the icon bar at the top of
the screen.

Zooming and Scaling

The View menu has Zoom operations pertaining to the screen view, and
Scale operations pertaining to the page view.

e Zooming makes the drawing details smaller without affecting the size
on the printed page. The text (constraints, output and annotation)
changes size with the rest of the drawing.

e Scaling adjusts the size of the geometry relative to the page, but the
text doesn't change size in the drawing window. Check View / Page
Boundaries to see this work.

The Scale functions used from the icon bar at the top of the screen can be
changed to Zoom functions by holding the ctrl key while clicking the icon.
This is handy if you need to change the size of the text on the screen:

= ] @)
e A Scaledown * followed by a Zoom in [ctrl] * has the effect

© 2012 Saltire Software



192 Geometry Expressions Manual

of enlarging the text.
= @
e A Zoom out [ctrl] * followed by a Scale up
shrinking the text on the screen.

* has the effect of

Toolbox Menus

The menus with the same name as the toolboxes at the side of the screen
just give another way of accessing the same functions.

Menu Option Selection

Draw Point Line Segment Infinite Line
Vector Polygon Circle
Ellipse Parabola Hyperbola
Arc N-gon Curve

Approximation

Text Picture Expression
Function

Annotate Angle Distance / Coefficients

Length

Coordinate Radius Expression
Direction Slope

Constrain Distance / Radius Perpendicular
Length
Angle Direction Slope
Coordinate Coefficients Tangent
Incident Congruent Parallel
Equation Proportional

Construct Midpoint Intersection Perpendicular

Bisector
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Calculate

Help Menu

Angle Bisector

Tangent to
Curve

Translation
Locus

Distance /
Length

Direction

Area

Parametric
Equation

Stop
Calculations

Parallel

Polygon

Rotation
Trace

Radius

Slope
Perimeter

Implicit Equation

Start
Calculations

193

Perpendicular

Reflection

Dilation
Area Under Arc
Angle

Coordinates

Coefficients

The Help menu lets you access this help system, check for updates,
change the program's language, and gives you information about the
program's license and version.

The menu selections are always available.

Menu Option
Dynamic Help

Contents. . .

Index. . .

Search. . .

License. . .

Function

Invokes the Help system

Look in the Table of Contents; add new or refer to
saved bookmarks.

Look in the Help index. There is also a facility to
Search index headings.

Search the Help topics for keywords.

Displays information about your license.
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Check for Prompts you to save your work, checks for new
Updates. . . versions of Geometry Expressions, then restarts
the program.

Contains the current version of the program, the
About. . . copyright notice, and the link to Geometry
Expressions' website.

NOTE: For the Mac version, About... is listed under Geometry
Expressions menu.

Context Menus

Context Menus pop up when you right-click with the cursor positioned
anywhere in the drawing window.

e The general context menu - appears when you right click and nothing
is selected.

e The selection context menu - appears when one or more elements in
the drawing window are selected. Some menu entries my be inactive,
depending on which elements are selected.

The General Context Menu

Right-click anywhere in the drawing window to display a context menu. If
nothing in the window is selected, the menu choices are the following:

Menu Option  Function When Available
Close Closes the current file Always
Save Updates a file that already The file has been
exists saved
Save As. .. Saves a file for the first time | Always
and prompt for the filename
and path
Select All Selects everything in the Always

drawing window
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Copy Drawing

Copy Region

Paste

Show All

Toggle
Hidden

Stop
Calculations

Start
Calculations

Copies everything in the
drawing window as an
Enhanced Metafile (.emf)

Copies a section of the
drawing window inside a
rectangle made by dragging
the cursor.

Puts whatever has been cut
or copied into the current
document

Displays any entities that
were hidden

Lets you toggle hidden /
visible for any object in the
drawing

Stop current calculations

Restart any stopped
calculations

Toggling - Hide / Show Elements

195

Always

Always

Object(s) cut or
copied

One or more element
(s) are hidden

Always

A calculation isn't
finished

A calculation is
stopped by users

From the general context menu select Toggle Hidden. The magic wand
cursor appears, and any hidden objects appear faintly in the drawing

window.
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Riemann Sum

Click faint items to display them. Click any displayed |tems to hide them.

......

When you are finished toggling, click the select arrow i*ii

Selection Context Menu

Select one or more drawing elements and right-click anywhere in the
drawing window to display a context menu. Selection context menus
contain some subset of the following list.

Menu Option Function When Available

Cut Deletes an object, but saves it | One or more
so it can be pasted somewhere | objects selected
else

Copy Does not delete the object, but | One or more
saves is so it can be pasted objects selected
somewhere else

Copy As Displays a submenu of choices | An expression or
for copying mathematics into formula is
other programs selected
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Send to
Mathematica

Paste

Delete

Hide

Edit

Parameters...

Arrange

Constrain
(Input)

Construct

Calculate
(Output)

Point Properties

Arrow Head

Inputs the math to
Mathematica when the algebra
system is running in another
window

Puts whatever has been cut or
copied into the current
document

Deletes whatever is selected,
without saving it.

Makes the selected objects
invisible

Lets you edit the domain of a
polar or parametric function or
the parameters of a locus or
trace.

For placing selected objects on
top of (bring forward) or
underneath (send backward)
other objects for easier
selection and viewing

Displays a submenu identical
to the one in the same drop-
down menu on the Menu Bar

Displays a submenu identical
to the one in the same drop-
down menu on the Menu Bar

Displays a submenu identical
to the one in the same drop-
down menu on the Menu Bar

Lets you quickly change point
color and point size

Lets you quickly turn off or
change arrow head style of the
selected segment(s)

An output
expression or
formula is
selected

Object(s) cut or
copied

One or more
objects selected

One or more
objects selected

A function, locus,
or trace is
selected

One or more
objects selected

Geometry
selected

Geometry
selected

Geometry
selected

One or more
points selected

One or more
segments
selected
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Line Properties Lets you quickly change line Any of the objects
color, line style, and line except point, text,
thickness of the selected object | and picture
(s) selected

Fill Properties Lets you quickly change color, | Polygon, N-gon,
style, and transparency level of | filled circle, filled
the selected object(s) ellipse, picture or

trace selected

Pinned Lets you quickly pin or unpin Text, picture, or
the selected object(s) expression

selected

Text Properties | Lets you quickly change text Text, label,

color, text size, and text style | expression,
constraint, or

measurement
selected
Show Symbol Lets you quickly turn symbol A constraint,
on and off annotation, or
measurement
selected
Output Lets you quickly turn output's One or more
Properties name, assumption or outputs selected
intermediate variables on and
off
Show Lets you quickly turn angle One or more
Arrowheads symbol's arrowheads on and angle symbol
off selected
Congruence Lets you quickly change angle | One or more
Style style from arcs to tics and vice | angle (or
versa congruent angle)
annotation
selected
Tic / Arc Count Lets you quickly change the One or more
number of tic/arc count to angle (or
display congruent angle)
annotation
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Axes Properties

All Properties. . .

[Convert to
Calculation
(Output)]

[Convert to
Constraint

(Input)]

[Convert to
Real]

[Convert to
Symbolic]

Lets you quickly turn the labels
on the axes on/off or change
the number of subdivision or
unit to display

Lets you edit the display
properties of the selected
object(s)

Deletes the selected constraint
and calculates the equivalent
output

Changes the calculation to an
input constraint

Changes a symbolic output to
a real output value

Changes a real output value to
a symbolic output expression

Axes Display Properties

199

selected

One or both axes
selected

One or several
similar objects
are selected

A constraint is
selected

An output
expression is
selected

A symbolic output
expression is
selected

A real output
value is selected

The Axes Display can be set in the default settings, Edit / Preferences
under the Grid, Axis, Page tab, or you can change them for an individual
drawing from the Selection Context menu.

To invoke the Selection Context menu:
1. Select one or both axes
2. Right click the mouse
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Cut

16 Copy

Copy As L
Paste

Delete

+4 | Arrange s

Axis Properties k » Show Lzbels »
Line Properties » Subdivisions
Text Properties L IInits L4

Al Properties...
12

The All Properties selection brings up all the Display Properties dialog
for the axes.

Display Properties E|
B Axes
Lime Calar - Black
Line Skyle Solid
Ling Thickness 1
Font 10; Swiss; Arial; Mormal; Mormal; Mot Underlined; Black.
Show Labels True
Decimal v
Subdivisions
Dedrees
Radians
Radians/3
[ 4 l [ Cancel ]

You can configure the X and Y axes in many ways. There are the usual
attributes of lines and text.

Show Labels - is useful when the axis labels lie under some part of your
diagram making it hard to read. You can turn these off on one or both
axes with the attribute set to False.

Units - can be set to the usual decimal, but with trig functions you may

find the Degrees, Radians or Radians/3 units more appropriate. If you
use the Degrees or Radians units, don't forget to set your Angle Mode to
Radians on the status bar.
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Cut
\ Copy /
Copy As b V=si
=sin(X
= Paste { ) '
Delete 180 60°
Arrange k
Axis Properties L Show Labels »
Line Properties k Subdivisions
Text Properties » Decimal
All Properties... ® Degrees
Radians
Radians/3
-4
T
ot Y=2-arcsinf(x)
Copy
Copy As r
Paste Y=arctan(Xx)
Delete
—
6 Arrange » 2 4
Axis Properties 4 Show Labels »
Line Properties b Subdivisions *
Text Properties b Decimal
All Properties... Degrees
# Radians
Radians/3
Tool Bar

The icons across the top of the screen make some of the routine tasks in
the File, Edit, and View menus, and Help easily accessible.

- See The Selection Arrow for more information.

DYE S

- See File Menu for more information.
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“EJP @ [E ) DRy - See Edit Menu for more information.
@, @ [l @ A See View Menu for more information.

q"'% q,ﬁ - See Output Calculations for more information.

@ Invokes the embedded Help facility
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What's New in Geometry Expressions?

Geometry Expressions is getting into everything! You can now make a
model into a Lua Applet for your TI-Nspire™ calculator.

Mac users can make Gx models into dashboard widgets and insert them in
their iBooks. Actually, Windows users can make widgets too and send
them to their Mac friends!

Now you have a choice of your mathematical precision type, significant
figures or decimal places. Check it out under Edit / Preferences / Math
in the Math section.

As requested by many GX users, we've added the ability to change
background color and to independently scale the axes in Graphing mode.

Where is the Geometry Expressions Website?

Information on upgrades, additional technical support and loads of great
examples can be found on the Geometry Expressions website at:
www.GeometryExpressions.com.

Can | See Some Examples?

Yes! We're on YouTube!

You can also sign up for a live Webinar. Send us a note and we'll get back
to you with a date and time.
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Index

.bmp 157
.emf 157
gx 32
gxw 32
Jjpg 157
.png 157
Aiff 157
xmp 157

_3-

3-Ddrawing 113

_A -

absolute value notation 137
ActionScript 182

adjusting
drawing 74
text size 191
angle

annotation 114
bisector 100
calculate 124
constraint 85
mode 15
supplement 124
animation 146
console 148
duration 148
export file 160
modes 148
parameter based 149
values 148
with Locus tool 149
annotation 110
angle 114
coefficients 116
congruent 117
congruentangle 118

coordinate 116
direction 115
distance 112
distinguish from constraints 77
expression 120
length 112
parallel 120
perpendicular 113
radius 112
slope 115
symbols 139
text 57
Applets 161, 170
Arcs 50
Area between curves 51
area calculation 127
area under the curve 109
assumptions 132

axes 43
scaling 176
units 199

_B -

Background color 24
bisector
angle 100
perpendicular 99

_C -

C 182

C# 182

C++ 182

calculations 121
angle 124
area 127
coordinates 127
direction 126
distance / length 123
implicit equations 129
parametric equations 129
perimeter 128
radius 123
slope 126
vector coefficients 128

Calculus 109

205
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check boxes 133 coordinates
circles 46 annotation 116
coefficients calculation 127
annotation 116 constraint 87
constraint 87 copy and paste mathematics 36
conflicts, constraint 81 Copy As
congruence 89 mathematics 180
angle annotation 118 MathML input 180
annotation 117 String input 180
constraints 75 curve approximations 56
angle 85 Curvilinear polygon 51
changing 77
conflicts 81 _ D _
congruent line segments 89

coordinate 87

o Dashboard Widgets 173
direction 86

di Defaults 28

!stgncg 83 ] text font 58

distinguish from annotations 77

i o1 degrees 15

equation dilation 104

incident 88 o
direction

length 83

annotation 115
calculate 126
constraint 86
Display 14
configuration 21
customizing 18
properties 130
Settings 28
distance
annotation 112
calculation 123
constraint 83
Distinguish Constraints / Annotations 77
division editing tool 136

parallel line segments 90

perpendicular 84

point proportional along curve 91

radius 84

slope 86

system added 78

tangents 88

vector coefficients 87
constructions 96

angle bisector 100

area under arc 109

dilation 104

intersection 98

locus of points 105

cus ¢ drawing

st 100 e 50
- . arcs 50

perpendicular bisector 99 circles 46

perpendicular lines 101

reflection 102

rotation 103

tangent 101

trace 107

translation 103
Context Menus 194

constraints 75

curve approximations 56
ellipses 47
expressions 60
hyperbola 49

line segments 42

lines 43
Convert to parabolas 48
Input / Output 196 points 41

Symbolic/ Real 196
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drawing
polygons 45
Preferences and Properties 40
regular polygons 55
text 57
tools 40
vectors 44

_E -

Edit Menu 177

Copy As 180
Preferences 28
Settings 28
Ellipse 47
envelope 105
Equations
constraint 91
implicit 91

implicit: calculating 129
examples 38
exporting drawings 157
Animation files 160
HTML 159
Image files 159
JavaScript Applet animated example
JavaScript Applet example 165
JavaScript files 161
Lua applets 170
widgets 173
Expression
annotation 120
Draw tool 60

_F -

Figure Gallery

controls 155

Import 153
File Handling 32

workbooks & individual files 33
File Menu 152

Export 157

Import from the Figure Gallery 153

import from the Geometry Atlas 155
functions 61

built-in 138

cartesian 62
domain 65, 67
f(X) 64

handles 62, 65, 67
list 143
parametric 67
piecewise 69
polar 65

-G -

Geometry Atlas 155
Graphing mode 176
Greek letters 135

_H -

help

using the Help system 11
Help Menu 193
Hide, toggle 195
HTML export files 159
Hyperbola 49

Icon Bar 201
image export 157
Image export files 159
Import files
from the Figure Gallery 153
from the Germetry Atlas 155
incidence 41, 88
Input constraints 75
integrals 109
intermediate veriables 132
intersections 98

_J -

Java 182

JavaScript export files 161
animated example 167
example 165

JavaScript, Source code 182
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S L -

length
annotation 112
calculation 123
constraint 83

line
infinite 43
intersections 98
parallel construction 100
segments 42

linked text 12

locking variables 146
using the lock 144

locus of points 105
curves and animation 149

Lua Apps 170,172
MathML 36, 180
Menus

Annotate 110
Calculate (Output) 121
Constrain (Input) 75
Construct 96

Context 194, 196

Draw 40

Edit 177

File 152

Help 193

View 188
Metafile 157
midpoints 98

move the drawing 74
multiple drawings 32

_N -

New features 204
N-gons 55

_0 -

Objective C 182

output
assumptions 132
calculations 121
check boxes 133
name 133
properties 130
window 188

_P-

page tabs 32

arranging 22
Parabola 48
parallel 90

annotation 120

construction 100
parametric equations

output 129
Parametric Variable 105, 107
parentheses for math notation
perimeter calculation 128
perpendicular

annotation 113

bisector 99

constraint 84

construction 101
Pictures 58
Piecewise Functions 69

parametric example 70
points 41

constrained along a curve
polygons

construction 102

drawing 45

regular 55
Preferences 28
Properties

Axes 199

‘R -

radians 15
radius
annotation 112
calculate 123
constraint 84
Reflection 102

137

91
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rotation 103

_S -

Scale 74,191
scaling the axes 176
screen layout 14
selecting
geometry 72
multiple objects 73

Settings 28
show output 133
slope

annotation 115
calculate 126
constraint 86
Smartboard Mode 74
source code 182
examples 183
square root editing tool 136
status bar 15
subscript / superscript 137
Supplemetary Angles 124
symbols 135
division 136
Greek letters 135
parentheses & absolute value 137
square root 136
subscript / superscript 137

- T -

tangents
text 57
Edit Text dialog 58
size 191
TI-Nspire
Script Editor 172
Toolbox Menus 192
toolboxes
arranging 19
configuration 21
floating / anchored 19
hiding / showing 20
Trace 107
translation 103

88, 101

_V -

variables 142
functions list 143
list 143
locking 146
value 146
VBA 182
vectors
calculate coefficients 128
constraints: coefficients 87
drawing 44
View Menu 188
Visual Basic 182

W -

Welcome 11
Widgets 173
Workbook files 33
workspace 32

_7 -

Zoom 74,191
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